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ПРЕДИСЛОВИЕ 

Настоящее учебное пособие подготовлено в рамках выполнения проекта 

ГК «Роснанотех» «Разработка и апробация программы опережающей про-

фессиональной переподготовки и учебно-методического комплекса (УМК), 

ориентированных на инвестиционные проекты ГК «Роснанотех» в области 

производства конкурентоспособной продукции наноэлектроники на основе 

наногетероструктурных монолитных интегральных схем СВЧ-диапазона 

длин волн и дискретных полупроводниковых приборов». Пособие предназна-

чено для слушателей программы переподготовки, ориентированных на при-

обретение компетенций в области новых технологий формирования кремние-

вых интегральных схем. Целью данного учебного пособия является изучение 

основ и получение навыков моделирования технологических процессов и 

приборов с использованием системы автоматизированного проектирования 

Synopsys TCAD. Исходя из намеченной цели, здесь не делается попытка опи-

сать этот комплексный продукт во всем многообразии. В состав указанного 

пакета входят разные модули для решения одних и тех же задач, и пользова-

телю предоставляются возможности выбора наиболее подходящих и удобных 

в использовании инструментов. Например, существуют модули Sentaurus 

Process, Dios и другие для технологического моделирования, имеющие ин-

терфейс командной строки, а также Ligament, позволяющий с использовани-

ем графического интерфейса построить технологический маршрут. В посо-

бии рассмотрен только Sentaurus Process, так как он позиционируется 

Synopsys как основной инструмент для решения задачи моделирования тех-

нологических процессов. Для построения расчетной сетки в пакете также  

существует несколько разных модулей, но внимание здесь уделено только 

одному из них. Предлагаемый материал ориентирован на инженеров, обла-

дающих базовыми знаниями по технологии производства и электрофизике 

полупроводниковых приборов. В качестве основы данного пособия взят учеб- 

ный материал Synopsys Sentaurus Training. 

Подраздел 5.2 и раздел 6 написаны К.Ю. Осиповым, остальная часть по-

собия и общая редакция выполнены Д.Д. Зыковым. 

Объем аудиторных занятий составляет 10 часов, и 10 часов отводится на 

самостоятельную работу. Слушателям рекомендуется в процессе переподго-

товки по мере освоения учебного модуля пройти самотестирование по вопро-

сам, сформулированным в приложении к данному пособию. 

 

 Д.Д. Зыков, канд. техн. наук, доцент 

 

 

 

 

 

 

 



 

1. ПРИБОРНО-ТЕХНОЛОГИЧЕСКОЕ МОДЕЛИРОВАНИЕ (TCAD) 

Приборно-технологическое моделирование, или TCAD (Technology Com-

puter Aided Design), – это область научных знаний и прикладных программных 

инструментов, позволяющих осуществлять многомерное моделирование инте-

гральных полупроводниковых структур, используя в качестве исходной ин-

формации описание технологического процесса их изготовления [1, 2]. 

Достоинствами TCAD являются универсальность, комплексность про- 

водимых исследований, возможность изучать интегральную структуру в  

процессе ее формирования, изменять, если потребуется, параметры техноло-

гических операций, выбирать оптимальные топологические размеры, места 

расположения контактов и т.д. В результате использования систем TCAD мы 

можем не только рассчитывать электрофизические параметры, электрические 

характеристики интегральных приборов, но и экстрагировать параметры схе-

мотехнических моделей, моделировать работу фрагментов схем, частью ко-

торых является, например, прибор, представленный как трехмерная инте-

гральная структура с заданными распределениями примеси и размерами. 

Приборно-технологическое моделирование является одним из основных 

элементов систем автоматизированного проектирования интегральных мик-

росхем. Существует несколько причин, по которым прогресс в области  

микро- и наноэлектроники сопровождается усилением роли приборно-техно- 

логического моделирования.  

В наноразмерных структурах  практически нет второстепенных парамет-

ров, а с уменьшением размеров элементов усиливается взаимосвязь техноло-

гических параметров и электрических характеристик интегральных прибо-

ров. Применение экспериментальных методов при исследовании областей в 

полупроводниковых структурах с размерами порядка 1–10 нм не дает высо-

кой точности результатов, необходимой для надежного прогнозирования 

приборных характеристик. Нельзя также обойтись только эксперименталь-

ными исследованиями при поиске и оптимизации принципиально новых при-

борных структур и конструктивных решений. Разумной альтернативой в этих 

случаях является использование численного моделирования. В дополнение к 

этому проблемой реального производства является сохранение высокого 

процента выхода годной продукции при уменьшении топологических разме-

ров и повышении сложности изделий. Сокращение этапа запуска в производ-

ство достигается с помощью предварительной отладки и оптимизации техно-

логических процессов и конструкций средствами приборно-технологического 

моделирования. Возможности TCAD позволяют иметь дело с виртуальным 

производственным процессом. На основе виртуального производства мы мо-

жем проводить анализ влияния разброса технологических параметров на 

приборные и схемотехнические характеристики, выбирать наилучшие реше-

ния с точки зрения выхода годных изделий и тем самым работать над повы-

шением технологичности выпускаемых микросхем. Подробнее этот вопрос 

рассмотрен в разд. 3. 

В условиях сокращения жизненного цикла изделий микроэлектроники и 

конкуренции между их изготовителями сроки и стоимость этапа разработки 



 

новых изделий и технологий  имеют определяющее значение. TCAD позволяет 

в кратчайшие сроки успешно решать проблемы, связанные с разработкой: 

− базовых технологических процессов; 

− конструкций интегральных элементов; 

− проектных топологических норм; 

− библиотечных элементов.  

Полученные результаты моделирования являются также необходимой 

частью информации при принятии решений, включая оперативное управле-

ние, краткосрочное планирование, анализ бизнеса и стратегий развития. 

Современные системы TCAD представляют собой комплекс программ-

ных модулей, интерактивных оболочек и средств визуализации, позволяю-

щих решать следующие задачи: 

− моделировать отдельные технологические операции, рассчитывать 

профили распределения примеси, толщины и электрофизические параметры 

слоев; 

− моделировать интегральные структуры, получаемые в результате по-

следовательности технологических операций – технологического маршрута; 

− рассчитывать на основе численного моделирования электрические, 

оптические, электромагнитные и другие характеристики полупроводниковых 

структур; 

− выполнять экстракцию схемотехнических параметров прибора по его 

электрическим характеристикам, рассчитывать фрагменты схем; 

− проводить планирование эксперимента, моделировать прохождение 

«виртуальной партии» пластин по базовому технологическому маршруту с 

расщеплением входных технологических параметров (сплит-партии); 

− выполнять оптимизацию параметров технологических операций, тех-

нологического маршрута, размеров элементов с целью получения заданных 

характеристик изделия. 

В международной технологической дорожной карте для полупроводни-

ков (ITRS) существует раздел, посвященный моделированию [3]. На рис. 1.1 

представлено начало одной из таблиц ITRS. 

Как видно из рисунка, в 2012 г. сокращение стоимости разработки тех-

нологии за счет использования TCAD должно достигнуть 37 %, а сокращение 

времени – 39 %. Это подтверждает значимость роли TCAD в мировой полу-

проводниковой промышленности. 

Возможности приборно-технологического моделирования позволяют ис-

следовать и оптимизировать приборные структуры самых разных типов. Сре-

ди новых направлений можно отметить моделирование глубоко субмикрон-

ных транзисторных структур с механически напряженным кремнием, анализ 

шумов в подложке и эффектов взаимного влияния интегральных элементов 

через подложку в схемах смешанного сигнала и системах-на-кристалле. По-

иск оптимальных решений в проектировании технологических маршрутов и 

приборных структур рассматривается как одно из основных применений 

приборно-технологического моделирования и разрабатываемых програм- 

мных пакетов. 
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В наше время приборно-технологическое моделирование стало связую-

щим звеном между дизайн-центрами и производством, обеспечивая разра-

ботку и проверку их интерфейса, т.е. проектных норм и библиотечных эле-

ментов.  

Системы TCAD позволяют осуществлять многомерное моделирование 

интегральных полупроводниковых структур, используя в качестве исходной 

информации описание технологического процесса их изготовления. Про-

граммная среда TCAD реализует концепцию виртуального производства  

интегральных полупроводниковых структур и обладает широкими возмож-

ностями для вовлечения студентов в активный творческий процесс исследо-

ваний и разработки конструкций наноразмерных интегральных элементов и 

технологических маршрутов их изготовления. 

 

2. ОПИСАНИЕ SYNOPSYS TCAD 

Sentaurus – это платформа TСАD фирмы Synopsys [4]. Объединивший 

лучшие свойства инструментов проектирования от компаний Synopsys и ISE 

TCAD, Sentaurus (рис. 2.1) позволяет пользователям решать широкий спектр 

задач: от создания глубоко субмикронной логики, памяти и цифро-

аналоговых приборов до сенсоров, оптоэлектроники и высокочастотной тех-

ники [5]. 

 

 

Рис. 2.1. Основные модули Synopsys TCAD 

Sentaurus Process 

Sentaurus Process – программный модуль для одно-, двух- и трехмерного 

моделирования процессов производства кремниевых и сложных полупровод-

ников, таких как ионная имплантация, диффузия, окисление, травление и 

осаждение слоев. 

Полное моделирование маршрута КМОП-технологии в 3D 

Стремительное развитие новых технологий требует от инженеров пони-

мания физических явлений, происходящих в теле транзистора, для оптимиза-

ции его характеристик. Примером может служить расчет механического 

напряжения в области канала, которое влияет на ток транзистора и требует 

построения трехмерной модели. 



 

Введение так называемой MGOALS-библиотеки значительно упростило 

построение такой модели и существенно сократило затраты машинного вре-

мени на этот процесс. MGOALS генерирует высококачественную трехмер-

ную сетку, а возможность ослабления критерия Delaunay вблизи границ раз-

дела способствует уменьшению требуемого числа узлов и снижает 

трудоемкость процесса без ущерба для расчета. 

Моделирование механического стресса 

Существуют широкие возможности для расчета механического стресса, 

включая модель рассогласования параметров кристаллической решетки, ко-

торая позволяет, например, контролировать напряжения, возникающие в ка-

нале SiGe транзистора и влияющие на ток транзистора. Также эта модель 

учитывает особенности структур на подложках из SiC, GaN, AlGaN. 

Для расчета упругих свойств кремния в зависимости от кристаллографи-

ческого направления используется модель анизотропной упругости. Есть 

возможность моделирования изгиба пластин. 

Для более точного прогнозирования стресса вблизи границ раздела слоев 

применяются граничные условия Neumann’a, что позволяет моделировать 

эффекты напряжения в кремнии, вызванные взаимодействием тонких пленок 

(рис. 2.2). 

 

Рис. 2.2. Результаты трехмерного моделирования механического стресса 

Исследование диффузии 

В моделировании диффузии имеются следующие возможности: 

 выбор любого нового набора параметров по желанию пользователей 

программы; 

 пятипоточная модель диффузии и модель междоузельной кластери- 

зации бора; 

 уточненные модели дефектообразования и кластеризации, получен- 

ные совместно с Университетом Флориды и фирмой FRENDTECH. 



 

Все модели диффузии в Sentaurus Process написаны на языке сценариев 

Alagator и одинаковы для одно-, двух- и трехмерного расчетов. Это означает, 

что модели примесей, дефектов, окисления и силицидирования так же не-

трудно изменять, как добавлять новые параметры расчета – примеси и мате-

риалы. 

Усовершенствованная модель расчета уплотнения осажденного оксида 

позволяет пользователю задавать процентное изменение его плотности в за-

висимости от температуры. 

Sentaurus Device 

Sentaurus Device – это программный модуль для моделирования электри-

ческих, термических и оптических характеристик кремниевых и сложных по-

лупроводниковых приборов. 

Он позволяет моделировать работу широкого спектра полупроводнико-

вых устройств, включая наноразмерные КМОП-транзисторы, FinFET, 

КМОП-датчики изображения, флэш-память, крупные мощные транзисторы, 

SiGe-биполярные гетеротранзисторы, аналоговые/высокочастотные транзи-

сторы, светоизлучающие диоды, лазеры. Кроме того, Sentaurus Device делает 

возможным анализ и оптимизацию электростатического разряда (ESD), еди-

ничного случайного сбоя (SEU) и кратковременной ошибки. Главные осо-

бенности Sentaurus Device: 

 возможность выбора одно-, двух- и трехмерной геометрии; 

 выбор материалов, включая гетеропереходы; 

 полный набор реальных транспортных моделей для различного 

применения (дрейфово-диффузионная, термодинамическая, гидродинами- 

ческая, квантовая); 

 усовершенствованная модель туннелирования для расчета затворных 

утечек; 

 модели инжекции горячих носителей для решения вопроса надеж- 

ности приборов; 

 расчет оптоэлектроники, включая светодиоды и лазеры; 

 набор различных режимов анализа – постоянный ток, переходный 

процесс, переменный ток, гармонический баланс, смешанная волна; 

 действенные численные алгоритмы с беспрецедентной устойчивостью; 

 современное программное обеспечение, позволяющее простое внед- 

рение новых моделей. 

Моделирование механического стресса 

Sentaurus Device предлагает ряд моделей, позволяющих точно описать 

воздействие стресса на подвижность носителей. Это феноменологические 

модели, основанные на тензорезистивности, и физические модели. 

Одна из них, учитывающая индуцированные стрессом изменения грани-

цы валентной зоны, позволяет менять уровень механического напряжения в 

области канала до 1,5 ГПа, и для моделирования КМОП с SiGe стоком-

истоком этого значения напряжения обычно вполне достаточно. 

 



 

Модели туннелирования носителей 

В расчетах работы гетероструктур и современных глубоко субмикрон-

ных КМОП-структур должно учитываться туннелирование носителей через 

потенциальный барьер. Для этого в Sentaurus Device есть несколько моделей, 

включая модель туннелирования Fowler-Nordheim’a, которая позволяет, в 

частности, с большой точностью предсказывать работу циклов записи и сти-

рания в электрически стираемой памяти ЭСППЗУ (EEPROM). 

Для случаев с прямым барьером, как при расчете затворной утечки через 

однослойный подзатворный оксид, может применяться модель прямого тун-

нелирования носителей, которая является полной квантово-механической 

моделью. 

Самая передовая модель туннелирования носителей в Sentaurus Device 

позволяет прогнозировать токи утечки через многослойный подзатворный 

диэлектрик, а также через барьер в контактах Шоттки. Она используется, 

например, для точного расчета эффекта плавающей подложки в частично 

обедненном n-канальном КМОП-КНИ-транзисторе, когда необходимо учи-

тывать туннелирование электронов из валентной зоны канала в зону прово-

димости затвора, которое может существенно повысить число дырок в под-

ложке. 

Моделирование работы элементов памяти SONOS 

Модель туннелирования носителей из ловушек в изоляторе важна для 

описания поведения подзатворного диэлектрика с высокой диэлектрической 

постоянной (high-k), так как плотность ловушек в нем обычно выше, чем в 

SiO2. Она также может использоваться для моделирования работы ячейки 

энергонезависимой памяти SONOS. 

Для элемента памяти SONOS характерна, в отличие от флэш-памяти или 

ЭСППЗУ, очень низкая подвижность носителей, захваченных ловушками  

в слое Si3N4. Для расчета распределения заряда в слое нитрида требуется мо-

делирование переходных процессов. 

Программа позволяет визуализировать распределение захваченных заря-

дов в слое нитрида и плотность носителей как функцию пространства и вре-

мени в процессе цикла записи-стирания. 

Моделирование радиочастотной техники 

Радиочастотные приборы характеризуются по времени их отклика на 

входной сигнал. Помимо моделирования переходных процессов, Sentaurus 

Device предлагает два пути расчета этого отклика: малосигнальный анализ 

(АС) и анализ в режиме гармонического баланса (НВ). 

Можно воспользоваться функцией визуализации АС-анализа: реакцию 

прибора и потоки тока/энергии при этом можно увидеть и произвести опти-

мизацию траектории малых токов для различных частот. 

В отличие от АС-анализа, НВ-анализ может применяться для моделиро-

вания сигналов произвольной амплитуды. Sentaurus Device обладает специа-

лизированными средствами для решения очень больших линейных систем, 

необходимого в НВ-анализе. 

 



 

Моделирование оптоэлектронных полупроводниковых приборов 

Sentaurus Device предлагает широкий выбор моделей для расчета таких 

оптоэлектронных приборов, как светоизлучающие диоды (LEDs), приборы с 

зарядовой связью (CCDs), КМОП световые сенсоры (рис. 2.3), объемные  

лазеры и лазеры на структурах с квантовыми ямами, вертикально-щелевые 

лазеры с поверхностными излучателями (VCSELs). 

Усовершенствованная модель лазера на GaN 

типе квантовых ям учитывает индуцированную 

напряжением поляризацию зарядов и эффекты из-

менения зонной структуры, вызванные высокой 

плотностью носителей. 

Поддерживается моделирование относитель-

ной интенсивности шумов (RIN) и их частоты в по-

лупроводниковых лазерах. Это делает возможным 

калибровку симулятора по экспериментально полу-

ченным данным. 

Для более точного расчета работы светоизлу-

чающего диода включена модель перепоглощения 

фотонов в двумерном и трехмерном исполнении. 

Модель Монте-Карло 

Метод Монте-Карло применяется для описания нелинейного квазибал-

листического транспорта носителей, который становится преимущественным 

в транзисторах с глубоко субмикронными размерами. Программа Sentaurus 

МОСА – метод Монте-Карло – включена как опция в состав Sentaurus Device 

начиная с версии Х-2005.10. 

Она содержит решение уравнения Шредингера, позволяющее учесть, 

например, такой квантовый эффект, как «отодвигание» электронов от грани-

цы раздела кремний-оксид, приводящее к снижению эффективной емкости 

затвора и тока транзистора. 

Sentaurus МОСА полностью интегрирована с остальными программами 

Synopsys TCAD: структура прибора может быть сгенерирована при помощи 

Sentaurus Process, а результаты приборного моделирования можно увидеть в 

Sentaurus Workbench. 

Построение сетки 

Sentaurus Device включает два различных средства для построения ко-

нечно-элементной сетки: Mesh и Noffset3D. 

Сеточный генератор Mesh на основе алгоритма Delauney генерирует сет-

ку для 1D-, 2D- и 3D-моделирования. Однако, если исследуемая поверхность 

непланарна, при построении сетки могут возникнуть некоторые трудности. 

Noffset3D вставляет слои параллельно поверхности в границах, опреде-

ленных пользователем, которые впоследствии можно преобразовать в сетку, 

позволяющую более точно определять, например, токи в области канала 

транзистора. 

И в Mesh, и в Noffset3D доступен способ генерирования сетки, позволя-

ющий создавать сетки типа Delauney под контролем пользователя. Точной 

 
Рис. 2.3. Результаты 

моделирования КМОП- 

фотодиода 



 

настройкой параметров пользователь может задавать необходимую сетку, 

при этом регулировать число узлов в ней, ослабляя требование Delauney в 

некоторых местах. 

Sentaurus Structure Editor 

Sentaurus Structure Editor предназначен для редактирования двух- и трех-

мерных структур и трехмерной эмуляции процессов. 

В режиме эмулятора процессов (Procem) Sentaurus Structure Editor пере-

водит шаги таких технологических операций, как травление и осаждение, фо-

толитография, полировка, в геометрические действия, и наоборот. Например, 

на стенки геометрически сгенерированной щели может быть осажден тонкий 

слой оксида при помощи простой операции осаждения. 

Используемые алгоритмы позволяют, в частности, моделировать направ-

ленное травление, которое используется в изготовлении ячейки флэш-памяти 

и качество которого (наклон боковых стенок вытравленной щели) сильно 

сказывается на характеристиках прибора. 

Sentaurus Workbench 

Обычно процесс моделирования предполагает, что пользователь запус-

кает несколько приложений последовательно. Sentaurus Workbench осу-

ществляет их взаимосвязь автоматически. 

Задав набор входных параметров (так называемое дерево экспериментов, 

DoE), например различное время отжига пластины или дозу ионной имплан-

тации, на выходе можно получить различные электрофизические характери-

стики прибора, а также оптимизировать их. 

Формат записи файлов TDR предназначен для рационального накопле-

ния, чтения и записи большого количества научных данных. Sentaurus 

Workbench включает графическое средство для просмотра и редактирования 

таких файлов – Sentaurus Data Explorer. 

Визуализатор Tecplot SV в составе Sentaurus Workbench позволяет стро-

ить разрезы любой структуры, причем работать в двух- и трехмерном режиме 

стало значительно проще. 

При помощи программного модуля Calibration Kit в составе Sentaurus 

Workbench Advanced можно калибровать профили, смоделированные в 

Sentaurus Process, TSUPREM-4 и Dios, по профилям, полученным методом 

вторичной ионной масс-спектроскопии. 

Sentaurus TCAD for Manufacturing 

Sentaurus TFM – это программный продукт, предназначенный для связи 

между миром моделирования процессов и отдельных компонентов схемы и 

миром проектирования схем и их верификации. 

Результаты моделирования технологии и физики прибора представляют-

ся в виде набора аналитических функций, называемого компактной процесс-

ной моделью – PCM. Этот набор является входным для дальнейшего схемо-

технического моделирования в SPICE. 

Известно, что преобладающим механизмом, наносящим убыток при про-

изводстве с топологическими нормами 90 нм и менее, становятся параметри-



 

ческие колебания из-за повышенной чувствительности характеристик таких 

приборов и схем к параметрам процессов. 

Быстрое и упрощенное многомерное моделирование процесс – прибор –

схема позволяет проанализировать факторы, которые могут приводить к по-

терям в производстве, связанным с параметрическими колебаниями. 

Sentaurus TFM, таким образом, представляет собой концепцию снижения 

параметрических потерь, позволяющую более эффективно контролировать 

всю линию процессов в полупроводниковом производстве и повышать выход 

годных изделий в соответствии с новым принципом взаимодействия произ-

водства и проектирования.  

 

3. ВИРТУАЛЬНОЕ ПРОИЗВОДСТВО  
С ИСПОЛЬЗОВАНИЕМ SYNOPSYS TCAD 

Cовременный рынок микроэлектроники выдвигает очень жесткие требо-

вания к проектам ИС с точки зрения технологичности, тестируемости и таких 

ключевых аспектов, как размер кристалла, потребляемая мощность, выход 

годных изделий и стоимость, поэтому все большее значение приобретает 

включение в процесс проектирования программной среды виртуального про-

изводства [2]. Все наиболее значимые результаты в области формирования 

программной среды виртуального производства представлены в программ-

ном пакете Sentaurus (TCAD фирмы Synopsys). В основе системы TCAD 

фирмы Synopsys лежат мощные вычислительные программные инструменты 

для моделирования технологических процессов и приборных характеристик 

Sentaurus Process и Sentaurus Device. К важным характеристикам автоматизи-

рованного рабочего места Sentaurus Workbench относятся средства для обес-

печения дружественного интерфейса с пользователем TCAD, включая графи-

ческие возможности для построения и редактирования сложных проектов, 

параметризацию входных файлов для автоматического запуска групп задач, 

организацию вычислительного процесса внутри проектов и директорий, что 

позволяет четко ориентироваться в вычислительной среде. Программные мо-

дули обеспечивают планирование эксперимента, оптимизацию и статистиче-

ский анализ в рамках проводимого исследования. 

Каждый проект Synopsys TCAD может содержать семейство сценариев, а 

каждый сценарий – семейство экспериментов. Внутри каждого эксперимента 

варьируется определенный входной параметр. Параметры могут вводиться в 

любой точке вычислительного процесса – от технологического моделирова-

ния до стадии расчета прибора. Параметризованный проект представляется в 

виде дерева, которое строится на основе описания вычислительного процесса 

(потока) и комбинации варьируемых параметров. Уровни дерева соответ-

ствуют вычислительным этапам. На каждом вычислительном этапе запраши-

вается столько инструментальных программ, сколько имеется узлов на дан-

ном уровне дерева семейств. Каждый вызов вычислительного средства 

характеризуется комбинацией значений параметров, которая определяется 

путем от корня дерева к точке вызова, т.е. к данному узлу дерева семейств. 



 

Любой узел дерева семейств имеет уникальный номер, и все выходные фай-

лы с результатами вычислений, проведенных в этом узле, содержат номер 

узла в своем имени. 

Cпециальные программы-редакторы позволяют сформировать тестовые 

структуры и образцы интегральных элементов и исследовать их отклик на 

внешние воздействия различного рода (электрические, электромагнитные, 

оптические, тепловые, механические и др.). Используемые для таких расче-

тов программы численного двух- и трехмерного моделирования обеспечи- 

вают работу виртуального комплекса в исследовательских целях, а также 

формируют набор данных для перехода к задачам схемотехнического проек-

тирования. Встроенный в цикл работы виртуального производства этап экс-

тракции схемотехнических параметров элементов готовит информацию для 

принятия решения о годности данных элементов по критериям, задаваемым 

дизайнерами схем, или о продолжении оптимизации технологического марш-

рута и  конструкции элемента. Взаимосвязь всех этапов создает условия для 

обоснованного выбора параметров критичных технологических операций, 

обеспечивающих наиболее устойчивые к технологическому разбросу значе-

ния схемотехнических характеристик. Наиболее выигрышным является ис-

пользование систем виртуального производства для анализа так называемых 

сплит-партий, или партий с «расщеплением» по одному или нескольким тех-

нологическим параметрам. В этом случае процесс моделирования фактически 

означает выполнение многофакторного виртуального эксперимента, постро-

енного по определенному плану.  

Обязательной частью системы виртуального производства являются про-

граммные средства для планирования эксперимента и анализа его результа-

тов с использованием специальных математических моделей. Такие исследо-

вания направлены на изучение чувствительности рабочих характеристик 

прибора к разбросу технологических параметров, на оптимизацию разраба-

тываемых структур с точки зрения повышения из технологичности. Структу-

ра виртуального производства включает наряду с прикладными программа-

ми, предназначенными для расчета процессов/приборов и визуализации 

результатов, вычислительные оболочки для  интеграции TCAD программных 

средств. Минимальный перечень задач, которые должны выполняться в рам-

ках  таких интегрирующих оболочек: 

− автоматическая интеграция программ в рамках моделируемых проектов;  

− организация пользовательского интерфейса к прикладным программам; 

− планирование эксперимента; 

− анализ зависимостей с использованием методологии поверхностей 

отклика; 

− статистический анализ результатов, оптимизация. 

 
 
 
 



 

4. ВОЗМОЖНОСТИ SYNOPSYS TCAD ДЛЯ ФИЗИЧЕСКОГО  
МОДЕЛИРОВАНИЯ ПОЛУПРОВОДНИКОВЫХ СВЕТОДИОДОВ 

Процесс физического моделирования работы светодиодов очень сложен 

в силу их больших геометрических размеров (несколько сотен микрометров и 

более) [6]. При моделировании столь больших структур использование стан-

дартных подходов к рассмотрению работы устройств с точки зрения элек-

тромагнитных явлений, происходящих в некоторой временной области, с по-

мощью методов конечных разностей и конечных элементов невозможно. 

Стандартные методы предполагают использование, как минимум, десяти  

точек для каждой длины волны излучения, в итоге результирующее количе-

ство точек для структуры светодиода, даже при использовании двухмерной 

сетки, превысит 10 миллионов. Альтернативой стандартным методам являет-

ся использование метода трассировки лучей, с помощью которого можно  

не только оценить оптическую интенсивность света внутри устройства, но и 

количество излучения, которое можно вывести наружу. Во многих случаях 

двухмерного моделирования недостаточно для точного учета всех физиче-

ских явлений, возникающих при работе светодиода, и возникает необходи-

мость использования трехмерной модели. 

Synopsys TCAD позволяет не только рассчитывать оптимальные кон-

струкции гетероструктур, но также дает возможность спроектировать кон-

струкцию устройства, обеспечивающую оптимальную экстракцию генериру-

емого излучения. 

4.1. Моделирование квантовых ям 

Поскольку процессы излучательной рекомбинации в современных при-

борах происходят не в объемных полупроводниках, а в гетероструктурах, то 

основное внимание следует уделить моделированию процессов, происхо- 

дящих в квантовых ямах. Явления диффузионно-дрейфового транспорта, 

описывающиеся гидродинамическими уравнениями и уравнениями непре-

рывности, не подходят для моделирования переноса носителей заряда через 

квантовые ямы, поскольку размер этих ям намного меньше, чем длина сво-

бодного пробега носителей. По этой причине для квантовых ям моделируют-

ся три основных явления: 

 захват носителей в квантовую яму; 

 процессы излучательной рекомбинации, происходящие в яме; 

 вычисление усиления. 

Процесс захвата носителей заряда в квантовой яме описывается с помо-

щью баллистического приближения. Рассматриваются следующие типы ре-

комбинации: 

 Оже-рекомбинация и рекомбинация Шоккли – Рида – Холла – обед-

няют квантовую яму и являются причиной возникновения темнового тока; 

 излучательная рекомбинация – включает в себя процессы спонтанной 

и вынужденной рекомбинации. 



 

Все эти типы рекомбинации должны быть включены в уравнения непре-

рывности для  выполнения закона сохранения частиц в системе.  

Для вычисления усиления используется золотое правило Ферми, которое 

количественно описывает излучательную эмиссию с помощью коэффициен-

тов спонтанной и вынужденной эмиссии. Эти коэффициенты содержатся в 

оптической матрице М, которая описывает вероятность процесса излучатель-

ной рекомбинации. Для вычисления оптической матрицы квантовой ямы 

необходимо знать структуру энергетических зон и волновые функции. 

Программный модуль Sentaurus Device (см. подразд. 5.2) предлагает три 

варианта для вычисления спектра усиления. 

1. Простая модель конечной ямы, имеющая аналитическое решение.  

В дополнение к этому эффекты, возникающие в результате напряжения 

структуры, и поляризационные эффекты учитываются в оптической матрице 

отдельно. 

2. kp-метод, учитывающий эффекты напряжения структуры и влияние 

носителей заряда друг на друга. При расчете с помощью данного метода ис-

пользуются гамильтонианы 4 4, 6 6, 8 8.  

3. Модели усиления, заданные пользователем и написанные на языке C++. 

4.2. Одномерное стационарное уравнение Шредингера 

По умолчанию Sentaurus Device использует простую модель конечной 

квантовой ямы, для этого в яме решается уравнение Шредингера. В кванто-

вой яме носители ограничены в одном направлении. Интерес представляют 

энергетические подзоны квантовой ямы и волновые функции связанных со-

стояний, которые могут быть найдены при решении уравнения Шредингера. 

При использовании простой модели квантовой ямы принимается допущение, 

что энергетические зоны электронов, тяжелых и легких дырок не связаны 

между собой, и энергетические подзоны находятся из решения одномерного 

уравнения Шредингера для каждой из этих зон отдельно. Используя прибли-

жение эффективной массы, стационарное одномерное уравнение Шредингера 

можно записать следующим образом: 

, 

где ζ
i
(x) – i-я квантово-механическая волновая функция; E

i
 – i-е собственное 

значение энергии; V(x) потенциал квантовой ямы конечной формы. 

Включение простой модели конечной квантовой ямы производится  

при помощи добавления в командный файл Sentaurus Device ключевых слов 

QWTransport и QWScatModel. 

4.3. kp-метод 

В Sentaurus Device также доступен более совершенный способ модели-

рования квантовых ям, который позволяет точнее вычислять энергетические 

подзоны, а также учитывать эффекты напряжения кристаллической решетки 

и влияния носителей заряда друг на друга. Используемый в Sentaurus Device 



 

kp-метод основан на модели Люттингера – Коха. Для расчета вырождения 

тяжелых и легких дырок, спин-орбитального расщепления и зон проводимо-

сти можно использовать гамильтонианы с размерами 4 4, 6 6 и 8 8. 

Согласно теореме Блоха волновая функция в периодической кристалли-

ческой решетке может быть представлена плоскими волнами следующим об-

разом: 

, 

где unk(r) – огибающая волновой функции, которая периодична на всей кри-

сталлической решетке, т.е. unk(r) = unk(r + R). Подставляя вышеописанное вы-

ражение в уравнение Шредингера, получим: 

.
 

В результате уравнение для нахождения собственных значений волновой 

функции будет выглядеть следующим образом: 

,
 

где гамильтониан Люттингера – Коха имеет вид 

,

 
где σ – спиновая матрица Паули; V – изменение потенциала в районе кванто-

вой ямы. 

На потенциал V могут оказывать влияние взаимодействия носителей за-

ряда друг с другом. В Sentaurus Device возможны два вида учета взаимодей-

ствия носителей заряда. 

1. Теория свободного носителя заряда (FCT), в которой предполагается, 

что носители заряда не взаимодействуют друг с другом и поэтому не вносят 

какие-либо дополнительные изменения в потенциал ямы. 

2. Модель многих тел, в которой учитывается кулоновское взаимодей-

ствие носителей заряда друг с другом. Учет данного эффекта производится 

путем введения экранированного потенциала Хатри – Фока (SHF). 

Таким образом, при использовании kp-метода эффекты смешения ва-

лентных зон и эффекты взаимодействия носителей заряда между собой иска-

жают зонную диаграмму полупроводника и ее форма становится не парабо-

лической. В этом случае интеграл, по которому считаются коэффициенты 

спонтанной и вынужденной эмиссии, необходимо брать в k-пространстве, а 

не в пространстве энергий. Основные особенности kp-метода: 

 доступны модели расширения усиления Лоренца и гиперболического 

косинуса; 

 для полупроводников с кристаллической структурой цинковой об-

манки (GaAs) можно выбрать гамильтонианы размерами 4 4, 6 6 и 8 8  

с учетом явлений взаимодействий носителей зарядов по моделям FCT и SHF; 

 для полупроводников с кристаллической структурой вюрцита (GaN) 

возможно выбрать гамильтониан размером 6 6 с учетом явлений взаимодей-

ствий носителей зарядов по моделям FCT и SHF; 

 экранирование пьезоэлектрических полей носителями заряда, нахо-

дящимися в квантовых ямах GaN, также может быть учтено при расчетах. 



 

4.4. Взаимосвязь электрической и оптической моделей 

Для моделирования работы светодиода необходимо решить систему, со-

стоящую из следующих дифференциальных уравнений: уравнения Пуассона 

(нахождение электростатического потенциала решетки), уравнения непре-

рывности электронов и дырок (соблюдение закона сохранения частиц), теп-

лового уравнения (нахождение температуры решетки) и уравнения Шредин-

гера (нахождение волновых функций электронов и дырок, а также энергий 

подуровней в квантовой яме). На рис. 4.1 показана схема взаимодействия 

между различными системами уравнений, применяемых при решении задачи 

моделирования работы светодиода.  

 

 

Рис. 4.1. Схема взаимодействия электрической и оптической моделей 

 

Моделирование происходит следующим образом. Сначала решается си-

стема уравнений, состоящая из уравнений Пуассона, непрерывности, транс-

портного и теплового уравнений, а также уравнений рассеяния в квантовых 

ямах. Результатом решения этой системы является плотность носителей заря-

да в активных областях прибора. Полученное решение подставляется в урав-

нение Шредингера, решая которое, находят скорость и плотность мощности 

спонтанной эмиссии фотонов, скорость спонтанной эмиссии передается в 

первую систему уравнений для подстановки в уравнения непрерывности 

электронов и дырок. 

Затем первая система заново решается с данными, полученными из ре-

шения уравнения Шредингера. Данная процедура повторяется до тех пор, 

пока решение не сойдется. После того как решение сошлось, плотность мощ-

ности спонтанной эмиссии, приходящаяся на каждый вертекс, находящийся в 

активной области прибора, передается в блок трассировки лучей. Также в 

этот блок передается информация о длине волны излучения, коэффициенте 

преломления материала и его абсорбционной способности. После выполне-

ния процедуры трассировки лучей в первую систему уравнений передается 

информация о лучах, проходящих через активную область и вызывающих 
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вследствие этого вынужденную эмиссию. Первая система уравнений решает-

ся с учетом этих данных, и весь цикл повторяется снова до тех пор, пока не 

будет достигнута сходимость всей системы. 

4.5. Выводы 

Спектр усиления спонтанного излучения светодиодов постоянно растет с 

увеличением подаваемого на прибор напряжения. Лимитирующим фактором 

этого роста является полное заполнение квантовой ямы носителями заряда. 

После того как произошло заполнение, ток утечки начинает быстро возрас-

тать. В связи с этим при проектировании светодиодов приходится решать две 

основные задачи. 

1. Эффективность экстракции. Данная проблема по большей части свя-

зана с геометрической формой устройства. Например, многие светодиоды 

имеют наклонные боковые стенки для улучшения вывода света из устрой-

ства. Угол наклона боковых стенок может быть задан в качестве переменной 

при планировании вычислительного эксперимента в программной оболочке 

Sentaurus Workbench. Для оптимизации геометрии прибора с целью повыше-

ния эффективности экстракции света имеется возможность автоматически 

подбирать наилучшее значение для заданной переменной. 

2. Равномерное распределение тока. Наилучшим вариантом является 

равномерное распределение тока по всей площади активной области прибора, 

это увеличивает общую интенсивность спонтанной эмиссии. Программный 

модуль Sentaurus Device позволяет отключить процедуру трассировки лучей 

при моделировании светодиода. При отключенной трассировке нельзя вы-

числить эффективность экстракции и диаграмму направленности излучения, 

но можно будет рассчитать полную мощность спонтанной эмиссии. Это поз-

волит намного быстрее добиться оптимизации структуры устройства с целью 

повышения равномерности распределения тока. 

Таким образом, программный пакет Synopsys TCAD позволяет произво-

дить детальное моделирование как электрических, так и оптических процес-

сов, происходящих в устройстве. Эти возможности позволяют разрабатывать 

гетероструктуры на основе полупроводников GaN и GaAs, а также произво-

дить расчет оптимальной конструкции светодиода. 

 

5. РАБОТА С МОДУЛЯМИ SYNOPSYS TCAD 

На рис. 5.1 представлена схема взаимодействия программных модулей 

Synopsys TCAD. 

Как видно из схемы, на вход программных модулей Sentaurus Process и 

Sentaurus Device подаются соответствующие командные файлы. При этом 

командный файл Sentaurus Process, содержащий описание технологического 

процесса в виде последовательности команд, может быть получен пользова-

телем двумя способами: 

 непосредственным набором в текстовом редакторе; 



 

 описанием технологического процесса в графической среде про-

граммного модуля Ligament, который затем автоматически сформирует ко-

мандный файл. 

На практике наибольшее распространение получил второй способ, кото-

рый и будет рассмотрен далее. 

 
 

 

Рис. 5.1. Схема взаимодействия программных модулей Synopsys TCAD 

Также следует отметить (см. рис. 5.1), что файлы структуры прибора мо-

гут быть получены как в результате технологического моделирования (напр-

мер, выходные файлы Sentaurus Process), так и в результате графического за-

дания структуры в Sentaurus Structure Editor. 

5.1. Sentaurus Process 

Sentaurus Process является основным модулем для моделирования техно-

логических процессов в пакете TCAD. В ISE TCAD он назывался Floops. 

Sentaurus Process позволяет выполнять одно-, двух- и трехмерное моде-

лирование. Здесь мы для примера рассмотрим двухмерный (Two Dimensional, 
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Ниже описываются основные широко используемые команды управле-

ния и моделирования процессов на примере 0,18 мкм n-канального MOSFET-

транзистора. В примере для простоты используются модели и параметры по 

умолчанию.  

 
5.1.1. Задание начальной двухмерной сетки 

Начальная сетка задается следующим списком команд:  

 
line x location= 0.0 spacing= 1.0<nm> tag=SiTop  
line x location=50.0<nm> spacing=10.0<nm>  
line x location= 0.5<um> spacing=50.0<nm>  
line x location= 2.0<um> spacing= 0.2<um>  
line x location= 4.0<um> spacing= 0.4<um>  
line x location=10.0<um> spacing= 2.0<um> tag=SiBottom  
 

line y location=0.0 spacing=50.0<nm> tag=Mid  
line y location=0.40<um> spacing=50.0<nm> tag=Right  
 

Sentaurus Process использует следующие оси координат: ось X – направ-

лена вниз (в подложку), ось Y – слева направо (параллельно пластине). 

Здесь используется зависящий от глубины (координата по X) шаг сетки, 

который меньше на поверхности пластины и больше по мере заглубления.  

В горизонтальной плоскости (ось Y) исполь-

зуется постоянный шаг сетки (рис. 5.2). Для 

дальнейшего использования также опреде-

лены теги (tag), обозначающие верх и дно 

пластины, а также середину и правую грани-

цу будущего устройства. 

Следует отметить, что Sentaurus Process 

проводит только одномерное моделирование 

до момента первого использования маски. 

Инициализация сетки для двухмерного мо-

делирования должна выполняться с большей 

аккуратностью, чем для одномерного, так 

как общее количество узлов сетки, от кото-

рого непосредственно зависит время расче-

та, вычисляется умножением шага по X на 

шаг по Y. Поэтому рекомендуется начинать с 

разреженной сетки. 

Узлы сетки будут добавлены автоматически по ходу моделирования. Из-

начально густая сетка замедлит расчет первых технологических операций. 

После запуска моделирования можно управлять построением сетки, изменяя 

правила посредством команды MGOALS. 

 

 
5.1.2. Область моделирования и инициализация 

 
Рис. 5.2. Начальная  

двухмерная сетка 



 

Начальная область моделирования задается командой region: 

 
region silicon xlo=SiTop xhi=SiBottom ylo=Mid yhi=Right 
init concentration=1.0e+15<cm-3> field=Phosphorus  
wafer.orient=100 

 

Для двухмерного моделирования область подложки определяется через 

теги по осям X и Y. Эти теги были определены ранее командой line.  

Здесь используется n-подложка с концентрацией фосфора 10
15

 см
–3

. За-

дана ориентация подложки (100), что является значением по умолчанию. 

 
5.1.3. Ионная имплантация 

Выполняются три операции имплантации бора: 
 

implant Boron dose=2.0e13<cm-2> energy=200<keV> tilt=0 rotation=0  
implant Boron dose=1.0e13<cm-2> energy= 80<keV> tilt=0 rotation=0  
implant Boron dose=2.0e12<cm-2> energy= 25<keV> tilt=0 rotation=0  

 

В каждом случае заданы доза и энергия имплантации, бомбардировка 

осуществляется перпендикулярно поверхности пластины. 

 
5.1.4. Выращивание подзатворного окисла 

Подзатворный окисел выращивается при температуре 850 °C в течение 

10 мин в чистом кислороде с использованием следующих команд: 
 

mgoals on min.normal.size=1<nm> max.lateral.size=2.0<um> \ 
normal.growth.ratio=1.4 accuracy=2e-5 
 

diffuse temperature=850<C> time=10.0<min> O2 
grid remesh 
select z=Boron 
layers 
 

Перед собственно шагом диффузии определяется стратегия построения 

сетки MGOALS. Ключевое слово O2 является сокращенным обозначением 

для среды чистого кислорода при давлении в 1 атм. Команда grid remesh 

принудительно создает сетку MGOALS в только что созданном слое оксида. 

Команда layers показывает, что толщина выращенного оксида составляет 

3,2 нм: 
 

{ Top Bottom Integral Material} 
{-2.46e-03 7.97e-04 2.67e+09 Oxide } 
{ 7.97e-04 1.00e+01 3.21e+13 Silicon} 

 
 

5.1.5. Создание поликремниевого затвора 

Поликремниевый затвор создается следующим образом: 



 

 

deposit poly type=anisotropic thickness=0.18<um> 
mask name=gate_mask left=-1 right=90<nm> 
 

etch poly type=anisotropic thickness=0.2<um> mask=gate_mask 
etch oxide type=anisotropic thickness=0.1<um> 
 

Сначала слой поликремния 0,18 мкм осаждается поверх всей структуры. 

Ключевое слово type=anisotropic означает, что слой выращивается только в 

вертикальном направлении. 

Далее с помощью команды mask определяется маска для защиты области 

затвора. В этом проекте моделируется только половина транзистора. Поэтому 

левая граница маски неважна и задано значение –1. Маске присвоено имя 

gate_mask для дальнейших ссылок на нее. 

Первая команда etch ссылается на только что созданную маску и поэтому 

травится только часть поликремния, не защищенная маской. Обратите вни-

мание, что заданная глубина травления (0,2 мкм) больше осажденного слоя. 

Избыточное травление гарантирует отсутствие остаточных островков. Задано 

анизотропное травление, поэтому применяемая маска проецируется строго 

вниз без какого-либо подтравливания. 

Второе выражение etch не использует маску, однако естественной мас-

кой выступает поликремний в выборочном процессе травления. Снова ис-

пользуется рассмотренное избыточное травление. 

 
5.1.6. Работа с масками 

Маски должны быть определены до того, как они будут использоваться. 

Например, imp_mask является блоком, располагающимся от –1 до 2 мкм и от 

4 до 20 мкм:  
 

mask clear 
mask name=imp_mask left=-1.0<um> right= 2.0<um> 
mask name=imp_mask left= 4.0<um> right=20.0<um> 
 

Маски могут быть инвертированы с помощью параметра negative. Для 

примера, etch_mask будет предотвращать травление от 2 до 4 мкм:  
 

mask clear 
mask name=etch_mask left=-1.0<um> right= 2.0<um> negative 
mask name=etch_mask left= 4.0<um> right=20.0<um> negative 
 

К командам, использующим маски, относятся implant, etch и deposit. 

Например, имплантация бора реализуется командой implant со ссылкой на 

предварительно объявленную маску:  
 

implant Boron mask=imp_mask dose=2e13<cm-2> energy=30<keV>  
5.1.7. Окисление поликремния 

Чтобы убрать напряженности, тонкая пленка оксида выращивается на 

поверхности поликремния перед формированием спейсера: 



 

 

diffuse temperature=900<C> time=10.0<min> O2 preszure=0.5<atm> \ 
 mgoals.native 

 

В данном случае значение давления по умолчанию в 1 атм заменяется 

явным указанием значения 0,5 атм. На всех этапах диффузии Sentaurus 

Process учитывает очень тонкий слой оксида, который всегда присутствует на 

кремнии и быстро формируется на вновь созданных поверхностях (рис. 5.3). 

Ключевое слово mgoals.native задает использование механизма MGOALS для 

формирования этого слоя, что рекомендуется для сложных геометрических 

структур. 

MGOALS автоматически воссоздает сетку в тонком слое оксида и в 

смежных слоях кремния и поликремния (рис. 5.4). 

 

        

Рис. 5.3. Окисление поликремния   Рис. 5.4. Сетка в тонком 

слое                                              оксида и смежных 

слоях                 поликремния и 

кремния 

 

Приведем дальнейшие команды технологического процесса: 
 

#--- LDD implantation –---------------------------------- 
refinebox silicon min= {0.0 0.05} max= {0.1 0.12} \ 
           xrefine= {0.01 0.01 0.01} yrefine= {0.01 0.01 0.01} add 
refinebox remesh 
 
implant Arsenic dose=4e14<cm-2> energy=10<keV> tilt=0 rotation=0   
diffuse temperature=1050<C> time=0.1<s> ; # Quick activation  
struct tdr=NMOS5 ; # LDD Implant 
 

#--- Halo implantation: Quad HALO implants –------------- 
implant Boron dose=0.25e13<cm-2> energy=20<keV> \ 
         tilt=30<degree> rotation=0             
implant Boron dose=0.25e13<cm-2> energy=20<keV> \ 



 

         tilt=30<degree> rotation=90<degree>    
implant Boron dose=0.25e13<cm-2> energy=20<keV> \ 
         tilt=30<degree> rotation=180<degree>   
implant Boron dose=0.25e13<cm-2> energy=20<keV> \ 
         tilt=30<degree> rotation=270<degree>   
 
#--- RTA of LDD/HALO implants –-------------------------- 
diffuse temperature=1050<C> time=5.0<s> 
struct tdr=NMOS6 ; # Halo RTA 
 
#--- Nitride spacer –------------------------------------ 
deposit  nitride type=isotropic   thickness=60<nm> 
etch     nitride type=anisotropic thickness=84<nm> 
etch     oxide   type=anisotropic thickness=10<nm> 
struct tdr=NMOS7 ; # Spacer 
 
#--- N+ implantation –----------------------------------- 
refinebox silicon min= {0.04 0.05} max= {0.18 0.4} \ 
           xrefine= {0.01 0.01 0.01} yrefine= {0.05 0.05 0.05} add 
refinebox remesh 
implant Arsenic dose=5e15<cm-2> energy=40<keV> \ 
         tilt=7<degree> rotation=-90<degree>   
 
#---  N+ implantation & final RTA –---------------------- 
diffuse temperature=1050<C> time=10.0<s>  
struct tdr=NMOS8 ; # S/D implants 

 
Пропустим описание этого блока, так как он реализуется способами, 

аналогичными уже рассмотренным, и перейдем к формированию контактных 

площадок. 

 
5.1.8. Контактные площадки 

Контактные площадки формируются следующим образом: 
 

deposit Aluminum type=isotropic thickness=30<nm> 
 
mask name=contacts_mask left=0.2<um> right=1.0<um> 
etch Aluminum type=anisotropic thickness=0.25<um> mask=contacts_mask 
etch Aluminum type=isotropic   thickness=0.02<um> mask=contacts_mask 
 

Моделирование реального процесса не производится. Металлические 

площадки создаются последовательным осаждением и травлением их для 

дальнейшего использования при моделировании прибора. Способ аналогичен 

примененному при создании поликремниевого затвора. 

 
5.1.9. Сохранение всей структуры 

Чтобы сохранить всю полученную структуру, необходимо: 



 

 

transform reflect left  
struct smesh=NMOS 
 

Сначала выполняется зеркальное отражение структуры относительно  

левой границы посредством команды transform. Затем вся структура сохраня-

ется с помощью команды struct. Ключевое 

слово smesh ука- зывает на создание всех 

файлов, необхо- димых для передачи 

структуры в про- граммные модули Mesh и 

Sentaurus Structure Editor. 

Структура также может быть сохра-

нена в старом формате DF-ISE следую-

щей командой: 
 

struct ise.mdraw=NMOS 
 

Итоговая структура представлена 

на рис. 5.5. 

 

 
5.1.10. Сохранение одномерных разрезов 

Одномерные разрезы могут быть сохранены в любой интересующей нас 

точке технологического маршрута следующим образом: 
 

SetPlxList   {BTotal NetActive} 
WritePlx NMOS_channel.plx  y=0.0 silicon 
 

SetPlxList   {AsTotal BTotal NetActive} 
WritePlx NMOS_ldd.plx y=0.1 silicon 
 

SetPlxList   {AsTotal BTotal NetActive} 
WritePlx NMOS_sd.plx y=0.35 silicon 
 

Результаты представлены на рис. 5.6, 5.7. 

 

 

 

 
 
 
 
 
 
 
 

Рис. 5.6. Зависимость 

концентрации акцептора 

(бор) в канале (черный 

 
Рис. 5.5. Итоговая структура 



 

цвет), в слабо легированной области (синий)  

и истоке/стоке (красный) от глубины 

 

 

 
 

 
 

 

 
 

 

 
 

 

 
 

 

Рис. 5.7. Зависимость 

концентрации доноров 

(мышьяк)  

в истоке/стоке (синий 

цвет) и слабо легиро-

ванной области  

(красный) от глубины 

 

 

 
 

 
 

5.2. Sentaurus Device 

Sentaurus Device является разносторонним модулем для моделирования 

полупроводниковых устройств, обеспечивающим эмуляцию электрических, 

температурных и оптических характеристик кремниевых и гетерострук-

турных приборов. Он позволяет работать с одно-, двух-, трехмерными моде-

лями в различных условиях функционирования устройства. 

 
5.2.1. Входной командный файл Sentaurus Device 

Рассмотрим структуру командного файла Sentaurus Device на примере 

моделирования вольт-амперных характеристик Si MOSFET, командный файл 

в данном случае выглядит следующим образом: 
 

File { 
 * input files: 
 Grid = «nmos_msh.tdr» 
 * output files: 
 Plot = «n1_des.tdr» 



 

 Current = «n1_des.plt» 
 Output = «n1_des.log» 
} 
 
Electrode { 
 { Name=«source» Voltage=0.0 } 
 { Name=«drain» Voltage=0.1 } 
 { Name=«gate» Voltage=0.0 Barrier=-0.55 } 
 { Name=«substrate» Voltage=0.0 } 
} 
Physics { 
Mobility (DopingDependence HighFieldSat Enormal) 
EffectiveIntrinsicDensity (BandGapNarrowing (OldSlotboom)) 
} 
 
Plot { 
eDensity hDensity eCurrent hCurrent 
Potential SpaceCharge ElectricField 
eMobility hMobility eVelocity hVelocity 
Doping DonorConcentration AcceptorConcentration 
} 
 
Math { 
 Extrapolate 
 RelErrControl 
} 
 
Solve { 
 #-initial solution: 
 Poisson 
 Coupled { Poisson Electron } 
 #-ramp gate: 
 Quasistationary (  
  Goal{ Name=«gate» Voltage=2 } ) 
  { Coupled { Poisson Electron } } 
} 

5.2.1.1. Секция File 

Как видно из примера, в первом блоке командного файла задаются фай-

лы входных и выходных данных. 
 

File { 
 * input files: 
 Grid = «nmos_msh.tdr» 
 * output files: 
 Plot = «n1_des.tdr» 
 Current = «n1_des.plt» 
 Output = «n1_des.log» 
} 



 

 

Разберем этот раздел подробнее. 

File { – эта строка открывает раздел описания файлов данных и результа-

тов моделирования. 

* input files: – комментарий, указывающий, что ниже будут заданы имена 

входных файлов. 

Grid = «nmos_msh.tdr» – входной файл, необходимый для моделирования 

(по умолчанию используется расширение *.tdr), где задана сетка, на которой 

будут решаться дифференциальные уравнения, а также области устройства, 

включая различного рода контакты. Sentaurus Device автоматически опреде-

ляет размерность модели, заданной в этом файле. Также в нем содержится 

информация о профилях легирования структуры устройства. 
* output files: – комментарий, указывающий, что ниже будут заданы име-

на выходных файлов. 

Plot = «n1_des.tdr» – выходной файл, в который будет записано итоговое 

пространственное распределение всех рассчитываемых величин (файл имеет 

расширение _des.tdr). Данный файл представляет собой структуру устройства 

с сеткой, идентичной той, что была задана во входном файле *.tdr. После рас-

чета в узлах этой сетки сохраняются значения переменных, указанных в сек-

ции Plot командного файла (описание секции Plot приводится ниже). 

Current = «n1_des.plt» – в этот файл записываются электрические выход-

ные данные (такие как токи, напряжения, заряды на электродах и т.д.). Обыч-

но имя файла имеет окончание _des.plt. В рассматриваемом примере отсут-

ствует секция CurrentPlot, где можно указать переменные, значения которых 

будут записываться в данный файл. В нашем случае будет записана только 

базовая информация о токах, напряжениях и зарядах на электродах устройства. 

Output = «n1_des.log» – в этой строке указано имя файла, в который бу-

дет записан лог (протокол работы Sentaurus Device). 

После описания всех файлов необходимо закрыть раздел, используя сим-

вол }. 

Следует отметить, что приведенный способ задания входных данных  
не является единственно возможным. В более ранних версиях программ- 

много модуля для задания  сетки и данных о легировании устройства  

использовались два различных файла с расширениями – *.grd и *.dat соответ-

ственно. Секция File при этом выглядела следующим образом: 
 

File { 

 * input files: 

 Grid = «nmos_msh.grd» 

 Doping  = «nmos_msh.dat» 

 * output files: 
 Plot = «n1_des.dat» 

 Current = «n1_des.plt» 

 Output = «n1_des.log» 

} 

 



 

Обратите внимание, что в этом случае выходной файл, указанный как 

Plot, также имеет расширение *.dat, т.е. в файле отсутствует информация о 

сетке, на которой получены данные. Для последующей визуализации данного 

файла необходимо использовать сетку файла, указанного как Grid, то есть 

файлы  n1_des.dat и nmos_msh.grd необходимо загружать в программный мо-

дуль Inspect вместе (см. подразд. 5.3). 

В более сложных случаях к входным файлам может добавляться файл 

параметров, имеющий расширение *.par. В данном файле задаются парамет-

ры моделей для материалов, используемых в расчетах. Подключается файл 

параметров следующей строкой: 
 

Parameter = «nmos.par» 
 

Еще одним важным моментом, на который следует обратить внимание, 

является использование в качестве имен файлов служебных переменных 

Sentaurus Workbench (SWB). Если Sentaurus Device интегрирован в проект 

SWB, нет необходимости использовать статические имена файлов, можно 

лишь указать имена переменных и SWB автоматически заменит их на имена 

файлов при процедуре предварительной обработки. Служебные переменные 

SWB имеют следующие имена: 

Входные файлы: 

 @grid@ – *.grd-файл сетки; 

 @doping@ – *.dat-файл легирования; 

 @tdr@ – *.tdr-файл структуры; 

 @parameter@ – *.par-файл параметров. 

Выходные файлы: 

 @plot@ – *.dat-файл данных; 

 @dat@ – *.plt-файл данных; 

 @tdrdat@ – *.tdr-файл данных; 

 @log@ – *.log-файл. 

В случае использования переменных секция File рассматриваемого при-

мера будет выглядеть следующим образом: 
 

 
File { 
 * input files: 
 Grid = «@tdr@» 
 * output files: 
 Plot = «@tdrdat@» 
 Current = «@plot@» 
 Output = «@log@» 

} 
 

Использование в качестве имен файлов переменных удобно при плани-

ровании больших экспериментов с десятками и сотнями входных и выходных 

файлов. 



 

5.2.1.2. Секция Electrode 

Следующая секция называется Electrode и содержит в себе информацию 

об электродах устройства, на которые будут подаваться и измеряться напря-

жения и токи. В Sentaurus Device электроды задаются с помощью электриче-

ских граничных условий и не содержат в себе сетку. В секции Electrode опре-

деляются все электроды, которые будут использоваться при моделировании 

работы устройства, а также начальные граничные условия и начальные 

напряжения смещения на них. Если структура имеет контакты, не описанные 

в данной секции, то они будут проигнорированы. 

Рассмотрим секцию Electrode, приведенную в примере: 
 

Electrode { 
 { Name=«source» Voltage=0.0 } 
 { Name=«drain» Voltage=0.1 } 
 { Name=«gate» Voltage=0.0 Barrier=-0.55 } 
 { Name=«substrate» Voltage=0.0 } 
} 
 

Electrode { – строка открывающая секцию описания электродов. 
 

{ Name=«source» Voltage=0.0 } – строка описания электрода: 

 

Name=«source» – задается имя электрода, в данном случае source, это 

имя должно в точности совпадать с именем, присвоенным электроду при со-

здании структуры устройства; 

Voltage=0.0 – начальное напряжение на данном контакте (в вольтах), с 

которого начнется расчет структуры. Если заданное значение будет сильно 

отличаться от нуля, велика вероятность, что начальное решение фундамен-

тальной системы уравнений (ФСУ) не сойдется. Для того чтобы избежать 

этой ситуации, следует указывать значения, близкие к нулю, а в случае необ-

ходимости получения большего напряжения на контакте – постепенно увели-

чивать его с помощью операции Quasistationary в блоке Solve. 

По умолчанию все контакты в структуре рассматриваются как омиче-

ские, то есть потенциальный барьер между областью полупроводника и обла-

стью контакта отсутствует. В случае необходимости задания неомического 

контакта к описанию добавляются параметры барьера: 
 

{ Name=«gate» Voltage=0.0 Barrier=-0.55 } 
 

В данном случае барьер задан с помощью выражения  
 

Barrier=-0.55 
 

Эта запись означает, что разность положений уровня Ферми материала 

контакта и материала полупроводника составляет –0,55 эВ. Если электрод 

является контактом Шоттки (например, затвор полевого транзистора), то пе-



 

ред заданием барьера необходимо включить соответствующую модель с по-

мощью команды Shottky. Задание такого контакта будет выглядеть следую-

щим образом: 
 

 { Name=«gate» Voltage=0.0 Shottky Barrier=-0.55 } 
 

Секция Electrode имеет гораздо больше возможностей, чем описано вы-

ше, для ознакомления с которыми необходимо обратиться к соответствую-

щей главе руководства пользователя Sentaurus Device [6]. 

5.2.1.3. Секция Physics 

В данной секции определяются физические модели, которые будут ис-

пользоваться при моделировании устройства. В частности, для нашего при-

мера достаточно указать базовые модели для расчета подвижности и ширины 

запрещенной зоны (а следовательно, и собственной концентрации носителей 

заряда). Для упрощения из примера был исключен расчет ряда потенциально 

важных эффектов (например, ударная ионизация), способных существенно 

повлиять на работу прибора. В итоге секция выглядит следующим образом: 
 

Physics { 
Mobility (DopingDependence HighFieldSat Enormal) 
EffectiveIntrinsicDensity (BandGapNarrowing (OldSlotboom)) 
} 
 

Строка Physics { – открывает секцию. 

Mobility (DopingDependence HighFieldSat Enormal) – задание модели по-

движности носителей заряда. В данном случае учитываются эффекты влия-

ния на подвижность концентрации легирующей примеси и температуры 

устройства (DopingDependence), моделируется эффект насыщения скорости в 

сильном электрическом поле (HighFieldSat), а также учитывается влияние на 

подвижность перпендикулярного электрического поля (Enormal). 

EffectiveIntrinsicDensity (BandGapNarrowing (OldSlotboom)) – задание 

модели расчета концентрации собственных носителей заряда, для этого рас-

считывается изменение ширины запрещенной зоны (BandGapNarrowing) по 

модели OldSlotboom. 

Для простого моделирования этого достаточно, однако при расчете ре-

альных устройств появляется необходимость учета множества эффектов и 

количество строк в данной секции может быть намного больше. С точки зре-

ния результатов моделирования данная секция является наиболее важной, 

поскольку именно набор физических моделей, используемых при расчетах, в 

конечном итоге определяет, насколько модель приближена к реальности. 

Полное описание всех физических моделей, поддерживаемых Sentaurus 

Device, можно найти в руководстве пользователя [6]. Следует помнить, что 

при подключении различных моделей в секции Physics происходит модифи-

кация уравнений решаемой симулятором ФСУ, и поэтому добавление или 

удаление некоторых моделей оказывает существенное влияние на сходимость 



 

решения системы. Если после добавления какой-либо модели решение пере-

стало сходиться, необходимо предпринять следующие действия. 

1. Проверить параметры модели и материала, заданные в файле *.par. 

2. Проанализировать содержание секции Math на предмет включения в 

нее команд, необходимых для корректной работы вновь добавленной модели. 

3. Проанализировать сетку устройства и при необходимости уменьшить 

ее шаг в областях, критичных для работы вновь добавленной модели. 

Как правило, одно из вышеуказанных действий позволяет решить про-

блемы со сходимостью. 

5.2.1.4. Секция Plot 

В секции Plot перечисляются имена переменных, значения которых бу-

дут записаны в выходной файл *.tdr. Для нашего примера секция будет вы-

глядеть так: 
 

Plot { 
eDensity hDensity eCurrent hCurrent 
Potential SpaceCharge ElectricField 
eMobility hMobility eVelocity hVelocity 
Doping DonorConcentration AcceptorConcentration 
} 

 

Строка Plot { – открывает секцию, в следующих за ней строках через 

пробел перечисляются названия переменных. Обычно имя переменной гово-

рит о том, какие данные она содержит, например: 

eDensity – плотность электронов;  

hDensity – плотность дырок; 

eCurrent – электронный ток; 

hCurrent – дырочный ток и т.д. 

Для того чтобы сохранить значения векторных величин, необходимо до-

бавить ключевое слово /Vector после имени переменной, например: 
Plot { eCurrent/Vector ElectricField/Vector } 

 
Полный список всех переменных, используемых в Sentaurus Device, при-

веден в приложении к руководству пользователя [6]. 

5.2.1.5. Секция Math 

Секция Math содержит настройки, отвечающие за решение ФСУ. 

Sentaurus Device в ходе своей работы решает систему дифференциальных 

уравнений в частных производных, расчет осуществляется итеративно на 

дискретной сетке. Для каждой итерации рассчитывается величина ошибки, и 

если эта величина меньше заданного значения, то предполагается, что реше-

ние сошлось. В секции Math можно указать величины минимально допусти-

мых ошибок для различных уравнений ФСУ, выбрать тип программы, ис-

пользуемой для решения уравнений, и многое другое. Более подробно 



 

команды, используемые в секции Math, описаны в руководстве пользователя 

[6]. В данном примере секция Math выглядит следующим образом: 
 

Math { 
 Extrapolate 
 RelErrControl 
} 
 

Строка Math { – открывает секцию. 

Extrapolate – команда, которая при квазистатическом смещении напря-

жения на электроде позволяет использовать в качестве начальных условий 

решения ФСУ данные, полученные путем экстраполяции двух предыдущих 

точек (если они существуют). 

RelErrControl – данная команда переключает проверку ошибок из режи-

ма по умолчанию в режим с настройками, указанными командами типа 

ErrRef, которые имеют более понятный физический смысл. 

5.2.1.6. Секция Solve 

Последняя секция в командном файле называется Solve. В ней определя-

ется последовательность задач, которые будут решаться Sentaurus Device.  

В приведенном примере начальное напряжение смещения на стоке составля-

ет 100 мВ, а напряжения на истоке и на подложке – 0 В. Для расчета ВАХ 

необходимо изменить напряжение на затворе от 0 до 2 В, при этом найдя  

решение во всех точках, находящихся в данном промежутке напряжений. По 

умолчанию количество точек внутри интервала рассчитывается по алгорит-

му, нацеленному на то, чтобы обеспечить наиболее надежную сходимость 

решения. В случае если решение не сходится, шаг изменения напряжения 

уменьшается и расчет производится вновь для более близкого к последней 

сошедшейся точке значения напряжения. Данные, полученные в процессе 

моделирования (напряжения, токи и заряды на электродах устройства),  

сохраняются в файле n1_des.plt после каждого шага, на котором решение  

сошлось. После окончания расчета данные можно посмотреть, воспользовав-

шись Inspect (см. подразд. 5.3). Рассмотрим секцию Solve, приведенную в при-

мере, более детально: 
 

Solve { 
 #-initial solution: 
 Poisson 
 Coupled { Poisson Electron } 
 #-ramp gate: 
 Quasistationary (  
  Goal{ Name=«gate» Voltage=2 } ) 
  { Coupled { Poisson Electron } } 
} 
 

Solve { – строка, открывающая секцию. 



 

#-initial solution: – комментарий, обозначает начало блока, в котором вы-

числяется начальное решение. 

Poisson – команда, рассчитывающая уравнение Пуассона, решение кото-

рого в дальнейшем используется как начальное решение для ФСУ. 

Coupled { Poisson Electron } – команда, решающая систему, состоящую 

из уравнения Пуассона и уравнения непрерывности для электронов. Началь-

ным предположением служит решение уравнения Пуассона, полученное на 

предыдущем шаге.  
 

 Quasistationary (  
  Goal{ Name=«gate» Voltage=2 } ) 
  { Coupled { Poisson Electron } } 
 

Выражение  Quasistationary определяет, какие квазистатические, т.е. 

находящиеся в равновесном состоянии, решения будут получены в ходе рас-

чета. Набор целевых значений напряжений, которые должны быть достигну-

ты на каждом из электродов, задается внутри скобок блока Goal. В данном 

примере последовательность решений находится для ряда напряжений на за-

творе, постепенно увеличивающихся от 0 до 2 В. Для этого решается система 

из уравнения Пуассона и уравнения непрерывности для электронов (выраже-

ние Coupled { Poisson Electron } ). 

В примере была рассмотрена базовая структура командного файла 

Sentaurus Device. В зависимости от цели и задач моделирования вид команд-

ного файла может претерпевать существенные изменения, но его базовая 

структура в целом остается неизменной. 

 
5.2.2. Запуск Sentaurus Device 

Запуск Sentaurus Device из командной строки осуществляется следую-

щим образом: 

> sdevice [command_file_name] 

Необязательный параметр [command_file_name] указывает на входной 

командный файл Sentaurus Device, например:  

> sdevice pp1_des.cmd 

Отображение списка параметров командной строки Sentaurus Device вы-

полняется следующим образом:  

> sdevice –h 

При каждом запуске Sentaurus Device сохраняет в файле журнала инфор-

мацию о процессе моделирования. Имя файла повторяет имя входного ко-

мандного файла, но имеет расширение.log. Файл журнала содержит, напри-

мер, версию Sentaurus Device и описание хоста, на котором он запущен, 

файлы структуры устройства, активные модели и применяемые параметры, 

отчет о решении и, возможно, сообщения об ошибках. 

 
5.2.3. Результаты расчета 



 

После окончания расчета 

данные записываются в выход-

ные файлы, имена которых бы-

ли указаны в секции File. Для 

просмотра файлов *.plt исполь-

зуется программный модуль 

Inspect (см. подразд. 5.3). Для 

рассмотренного примера если 

внешнее напряжение на затворе 

(переменная OuterVoltage в раз- 

деле электрода gate) отложить 

по оси X, а электронный ток 

стока (переменная eCurrent в 

разделе электрода drain) отло-

жить по оси Y, то в итоге полу-

чим изображение, показанное 

на рис. 5.8.                                                      

Каждая точка на графике 

соответствует решению ФСУ 

при определенном постоянном 

напряжении на затворе. Как 

видно из рисунка, шаг изменения напряжения составил 0,1 В и был постоянен 

на протяжении всего расчета. 

5.3. Sentaurus Inspect 

Inspect является модулем, предназначенным для эффективного просмот-

ра графиков, кроме того, он позволяет экстрагировать параметры. Пользова-

тель может в интерактивном режиме настраивать отображение кривых на 

графике, используя для этого скрипты. 

Inspect содержит большой набор математических функций, выполняе-

мых над кривыми, например дифференцирование, интегрирование, нахож- 

дение максимума и минимума. Язык скриптов Inspect основан на Tcl и по-

этому унаследовал его гибкость и функциональность. 

Следует отметить, что для получения многооконных графиков, гото- 

вых для презентаций, рекомендуется использовать программный модуль 

Tecplot SV. 

 
5.3.1. Запуск Inspect 

Чтобы запустить Inspect, необходимо набрать в командной строке  

> inspect 

В качестве рабочего каталога Inspect примет текущий каталог. 

Inspect также может быть запущен из Sentaurus Workbench или 

Tecplot SV. 

После запуска на экране отобразится главное окно Inspect (рис. 5.9). 

Рис. 5.8. Зависимость тока стока 

от напряжения на затворе 
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Главное окно содержит следующие компоненты: 

− меню и панель инструментов; 

− правую часть занимает область графиков, где отображаются кривые;  

− левая часть имеет две области: Datasets (наборы данных) и Curves 

(кривые).  

 

Рис. 5.9. Графический интерфейс пользователя Inspect 

Область Datasets отображает загруженные файлы наборов данных с их 

компонентами. Кнопки To X Axis, To Left Y Axis и To Right Axis, располо-

женные под областью Datasets, используются для отображения наборов дан-

ных по соответствующим координатным осям. 

Область Curves отображает имена существующих кривых; ниже распо-

ложены кнопки New, Edit и Delete; кнопка New предназначена для создания 

кривой с использованием библиотеки формул, кнопка Edit – для изменения 

параметров отображения кривой, а кнопка Delete удаляет выделенные кривые. 

Строка состояния внизу окна отображает информацию о текущей сессии 

Inspect и положении указателя в области графиков. 

 
5.3.2. Загрузка наборов данных 

5.3.2.1. Форматы файлов 



 

Перед отображением необходимо загрузить в Inspect файл, содержащий 

множество наборов данных. Файл может иметь формат DF-ISE .plt или про-

стой формат столбцов. Файлы формата DF-ISE .plt обычно являются выход-

ными файлами программного модуля Synopsys TCAD, в частности Sentaurus 

Device. Такой файл может называться, например, n1_des.plt. 

Файл в простом формате столбцов должен начинаться со строки коммен-

тария в двойных кавычках, затем должны следовать два столбца данных: 

«This is a comment line.» 
1 0.1 
2 0.5 
3 0.9 
... 

5.3.2.2. Загрузка 

Для загрузки наборов данных при запуске Inspect из командной строки 

наберите 

> inspect n1_des.plt 

n1_des.plt – имя файла, содержащего необходимые наборы данных, например 

ток стока с напряжением на затворе. Можно сразу загрузить более одного 

файла, перечислив их имена в командной строке, например:  

> inspect n1_des.plt n2_des.plt n3_des.plt ... 

Если сессия Inspect уже запущена, можно загрузить файлы, используя 

команду меню File > Load Datasets или щелкнув соответствующий значок в 

панели управления.  

В результате Inspect откроет диалоговое окно Load Dataset (рис. 5.10),  

в котором можно ввести имена файлов или выбрать их в окне. 

 

 

Рис. 5.10. Диалоговое окно 
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После того как файл наборов данных загружен, его имя отображается в 

области Datasets. В среднем поле области отображается список имен групп 

данных выбранного файла, а в нижнее поле – имена наборов данных, принад-

лежащих выбранной группе (рис. 5.11). 

 

 

Рис. 5.11. Главное окно, содержащее информацию  

о наборах данных в области Datasets 

5.3.3. Отображение наборов данных 

Так как загруженный файл может содержать более двух наборов данных, 

Inspect не пытается автоматически определить по местоположению в файле, 

какие наборы следует отобразить по осям X и Y. Напротив, пользователь 

должен явно указать их после загрузки данных. Для этой цели служат кнопки 

To X Axis, To Left Y Axis и To Right Y Axis. 

Например, чтобы отобразить по оси X на графике набор данных 

OuterVoltage из группы gate файла n1_des, необходимо выполнить следую-

щие действия. 

1. Выбрать файл данных n1_des в верхнем поле области Datasets.  

2. Выбрать группу данных gate в среднем поле.  

3. Выбрать набор данных OuterVoltage в нижнем поле.  

4. Щелкнуть кнопку To X Axis.  



 

5. Отображение по осям Y, левой и правой, может быть задано анало-

гичным образом щелчком по кнопкам To Left Y axis и To Right Y axis. (При 

необходимости можно отобразить более одного набора данных по одной оси Y.) 

Для примера на рис. 5.12 изображен график зависимости тока стока 

(набор данных TotalCurrent из группы drain по левой оси Y) от напряжения 

на стоке (OuterVoltage по X). 

 

 

Рис. 5.12. График зависимости тока от напряжения на стоке 

5.4. Sentaurus Workbench 

Sentaurus Workbench является главной графической оболочкой, которая ин-

тегрирует программы моделирования в единую рабочую область. Она исполь-

зуется для разработки, организации и выполнения процесса моделирования. 

Процессы моделирования комплексируются в проекты. Sentaurus 

Workbench автоматически организует передачу информации, включая пред-

варительную обработку входных файлов пользователя, параметризацию про-

ектов, настройку и запуск экземпляров модулей и представление результатов. 

Sentaurus Workbench позволяет определить параметры и переменные для 

выполнения комплексных параметризованных исследований (анализов). По-

лученные результаты могут быть затем обработаны с использованием стати-

стического и табличного программного обеспечения. 



 

 
5.4.1. Запуск Sentaurus Workbench 

Запуск Sentaurus Workbench выполняется командной строкой: swb. 
После запуска Sentaurus Workbench отображает на экране главное окно 

(рис. 5.13), включающее содержимое рабочего каталога (выделено на рисунке 

синей рамкой). Проекты Sentaurus Workbench отображаются значком  

слева от их названия. 

 

 

Рис. 5.13. Главное окно Sentaurus Workbench 

Для открытия существующего проекта необходимо дважды щелкнуть на 

его названии в рабочем каталоге. 

Открытый проект отображается в правой части главного окна программы 

(рис. 5.14). 
 

 

 Рис. 5.14. Главное окно Sentaurus Workbench, отображающее маршрут модулей (1), 

параметры (2) и узлы моделирования (3) – отмечены черной рамкой 



 

 Маршрут модулей представляет собой связанную последовательность 

программ моделирования, составляющих проект. В по-

казанном примере это Sentaurus Process, Sentaurus Struc-

ture Editor, Sentaurus Device и Inspect (см. рис. 5.14). 

Ниже маршрута модулей отображаются узлы [n1], [n2] 

и т.д. 

Включение отображения номеров узлов произво-

дится посредством команды главного меню View > 

Tree Options > Show Node Numbers. 

Одна цепь узлов моделирования (по одному узлу 

для каждой программы в маршруте) составляет один 

эксперимент (experiment). При использовании парамет-

ров возможно создание произвольного числа экспери-

ментов. 

Справа от маршрута модулей отображаются пере-

менные и экстрагированные (extracted) электрические 

параметры. После завершения моделирования экстра-

гированные значения появляются в соответствующих 

столбцах. 

Чтобы узнать параметры любого узла, необходимо 

дважды щелкнуть на его ячейку в окне. При этом отоб-

ражается диалоговое окно с информацией об узле (рис. 

5.15). 

В окне отображаются номер узла, соответствую-

щий программный модуль, соответствующий параметр 

и его значение, статус узла, дата и время моделирова-

ния, имя компьютера, на котором было выполнено мо-

делирование, и полное время продолжительности мо-

делирования. Из перечисленного меняется только 

статус узла, который может использоваться в различ-

ных случаях для контроля процесса выполнения экспе-

риментов. 

 Диалоговое окно также отображает экстрагированные и установленные 

переменные, показывает параметры от предыдущих шагов и их значения. 

Каждый узел моделирования в проекте имеет цвет, который отображает 

его состояние (status). Диаграмма цветов в нижнем правом углу главного ок-

на Sentaurus Workbench (рис. 5.16) показывает смысловое значение каждого 

цвета.  
 

 

Рис. 5.16. Цвета, обозначающие различные состояния узлов  

 

 
Рис. 5.15. Диалоговое окно  

с информацией об узле 



 

Например, в нашем случае, когда был открыт проект (см. рис. 5.14), узлы 

были желтого цвета. Это означает, что в прошлом моделирование этих узлов 

закончилось успешно. 

Прежде чем запустить проект, может потребоваться удалить результаты 

предыдущего моделирования. 

Для того чтобы очистить проект, необходимо выполнить следующие 

действия. 

1. Project > Clean Up.  

2. В диалоговом окне Clean Up Options (рис. 5.17) отметить элементы, 

подлежащие удалению.  

3. Нажать OK. 

 

Рис. 5.17. Диалоговое окно Clean Up Options 

 

В данном случае Sentaurus Workbench удалит все файлы, связанные с 

предыдущим запуском, что отразится в смене цвета узлов с желтого (выпол-

нено – done) на белый (отсутствует – none). 
5.4.2. Запуск проектов 

Чтобы запустить расчет проекта, необходимо выполнить следующее. 

1. Меню Project > Run или сочетание клавиш Ctrl+R (или щелкнуть на 

иконку Run в панели инструментов).  

2. В диалоговом окне Run Project (рис. 5.18) щелкнуть Run, чтобы вы-

полнить расчет всего проекта. 



 

 

Рис. 5.18. Диалоговое окно Run Project 

 

Если требуется рассчитать только несколько узлов, то в поле Nodes диа-

логового окна необходимо ввести их номера. Например, «15 16» – для расче-

та узлов 15 и 16. 

Затем Sentaurus Workbench производит расчет проекта, о чем свидетель-

ствует появившееся диалоговое окно Project Log (рис. 5.19), которое отобра-

жает текущий статус расчета проекта. 

После запуска расчета каждого узла Sentaurus Workbench выводит сооб-

щение, аналогичное следующему: 

>>>>>>>>>> job '10' status changed from 'pending'  
to 'running'  
09:34:49 Jul 19 2005 job 10 <sprocess> started on  
host 'hude-d740-lnx': «/remote/tcadprod/bin/sprocess –u n10_fps.cmd» 

Перед выполнением расчета узла Sentaurus Workbench осуществляет 

предварительную обработку входных файлов, что включает проверку синтак-

сиса и подстановку значений параметров и переменных. После успешной об-

работки файлов Sentaurus Workbench создает готовые для расчета входные 

файлы, имеющие имена вида pp<node_number>_<tool_name>.cmd и 

pp<node_number>_des.par (файл параметров Sentaurus Device). 

 

 



 

 

Рис. 5.19. Диалоговое окно Project Log 

 

Когда расчет проекта успешно завершен, Sentaurus Workbench отобража-

ет следующее сообщение в диалоговом окне Project Log: 

SCHEDULING REPORT 
+++ done : 40 39 41 42 43 44 45 46 47 48 50 49 51 52 53 54 55 56 57 58 
60 59 61 62 10 11 12 13 14 21 22 23 24 25 26 9 
10:10:33 Jul 19 2005 <SWB_nmos> done (2146 sec) 
>>>>>> Writing to status file 2146 
gsub exits with status 0 
 

К этому моменту завершена экстракция всех переменных, значения ко-

торых отображаются справа от маршрута модулей в главном окне Sentaurus 

Workbench. 

 
5.4.3. Отображение результатов 

Каждый узел имеет набор соответствующих ему входных и выходных 

файлов, которые можно отобразить, щелкнув правой кнопкой мыши и выбрав 

Visualize. Для просмотра любого текстового файла или файла журнала необ-

ходимо выбрать его в списке. 



 

Все выходные файлы данных Sentaurus Process – Mdraw, Sentaurus Device – 

могут быть отображены с помощью Tecplot SV, а файлы .plx и .plt Sentaurus 

Device – с помощью Inspect. 

Дополнительно может быть отображена информация, записанная в стан-

дартный выходной поток программы в процессе расчета. Для этого необхо-

димо выбрать в контекстном меню узла View Output или щелкнуть на иконке 

 в панели задач. 

 
5.4.4. Выбор узлов 

Для произвольного узла в проекте могут быть выделены все узлы, пред-

шествующие ему в эксперименте и следующие за ним. Это может быть сде-

лано по состоянию узлов или инверсии их состояния. Такая возможность 

очень полезна, в особенности при управлении очень большими проектами с 

множеством параметров. 

Приведем несколько примеров. 

1. Click node 2. Щелкните на узле 2. 

2. Выберите пункт меню Nodes > Extend Selection To > Leaves.  

3. Затем Nodes > Extend Selection To > Root.  

4. Очистить выделение: Nodes > Deselect All.  

5. Измените состояние узла 9 с done на none.  

6. Меню Nodes > Select > By Status > done. В результате только узел 9 

остался не выделенным. 

То же самое может быть достигнуто инверсным выделением: 

 Меню Nodes > Select > Inverse Of > none. 

 
5.4.5. Удаление проектов 

Для удаления проекта: 

1) выделите проект в окне проектов Projects; 

2) щелкните правой кнопкой мыши и выберите Delete. 

Если появится сообщение об ошибке (рис. 5.20), то проект необходимо 

закрыть перед его удалением. 

 

Рис. 5.20. Диалоговое окно сообщения об ошибке 

 

В этом случае щелкните OK и выберите пункт меню Project > Close,  

в результате чего проект исчезнет с главного окна программы. 

Теперь повторите пп. 1–2 и выберите Yes в появившемся диалоговом  

окне. 



 

5.4.6. Создание проектов 

Чтобы создать проект, выберите пункт меню Project > New или щелкни-

те по значку  на панели инструментов. 

Это создаст временный проект с именем, похожим на g_lnx_2879_0.tmp, в 

папке tmp, который можно наблюдать в окне проектов Projects (рис. 5.21). 
 

 

Рис. 5.21. Вновь созданный проект в дереве каталогов проектов 

5.4.6.1. Создание маршрута модулей 

Перед созданием маршрута модулей необходимо создать проект. 

Например, наш маршрут будут составлять следующие модули в указан-

ном порядке: Sentaurus Process, Sentaurus Structure Editor, Sentaurus Device и 

Inspect. 

Для создания маршрута модулей щелкните правой кнопкой мыши на по-

ле No Tools в столбце Family Tree (рис. 5.22) и выберите пункт Add Tool  

в появившемся контекстном меню. 

 

Рис. 5.22. Часть главного окна, используемая для создания маршрута модулей 
 

В результате на экране появится диалоговое окно Add Tool (рис. 5.23). 

 

Рис. 5.23. Диалоговое окно Add Tool 
 



 

Поле Tool Name задает имя, по которому можно обратиться к данному 

конкретному экземпляру модуля Sentaurus Process. Пользователь может  

задать здесь любое имя по своему усмотрению, оно не ограничивается 

sprocess, использованном в данном примере. (Возможность задания произ-

вольных имен полезна, когда один и тот же программный модуль использу-

ется несколько раз в маршруте. В этих случаях первый экземпляр Sentaurus 

Process можно было бы назвать sprocess1, второй – sprocess2 и т.д. или ис-

пользовать любые другие имена по усмотрению пользователя.) 

В поле DB Tool выберите sprocess из списка модулей. Щелкните OK, 

чтобы закрыть диалоговое окно и добавить модуль в маршрут. 

Отметьте параметр Use Ligament, в этом случае Sentaurus Process будет 

использовать входные файлы в формате Ligament. 

Задайте, чтобы Sentaurus Process запускался в пакетном режи-

ме (batch mode). 

1. Щелкните правой кнопкой мыши на иконке Sentaurus 

Process и выберите пункт контекстного меню Edit Input > Prefer-

ences, чтобы отобразить диалоговое окно Edit Preferences (рис. 

5.24).  

2. Отметьте параметр Start in batch mode.  

3. Щелкните OK.   

Затем отобразится диалоговое окно Create Default 

Experiment, где может быть создан сценарий выполнения (рис. 

5.25). 

Чтобы задать имя сценария: 

1) введите new в качестве имени сценария;  

2) щелкните OK. 

Теперь необходимо задать входные файлы для 

Sentaurus Process в формате Ligament. Можно импортиро-

вать их из учебного проекта SWB_nmos, поставляемого 

вместе с Synopsys TCAD. 

Чтобы импортировать файлы: 

1) щелкните правой кнопкой мыши на иконке Sentaurus Process и выбе-

рите пункт контекстного меню Import File > Ligament Flow; 

2) в появившемся диалоговом окне Import Flow File перейдите в папку 

SWB_nmos в дереве каталогов и выделите sprocess_lig.cmd (рис. 5.26);  

3) щелкните Open. 

Аналогичным образом щелкните правой кнопкой мыши на иконку 

Sentaurus Process, выберите пункт контекстного меню Import File > Ligament 

Layout и импортируйте файл sprocess_lig.lyt. (Пользователь также может вы-

полнить Edit Input > Ligament Layout, чтобы запустить Ligament Layout 

Editor и создать начальную структуру.) На этом добавление модуля Sentaurus 

Process полностью завершено. 

 

 

Рис. 5.24. Диалоговое 

окно Edit Preferences  

 для Sentaurus Process 

 

Рис. 5.25. Диалоговое окно  

Create Default Experiment 



 

 

Рис. 5.26. Диалоговое окно Import Flow File 

 

Чтобы добавить Sentaurus Structure Editor: 

1) щелкните правой кнопкой мыши на иконке Sentaurus Process и выбе-

рите пункт контекстного меню Add; 

2) в диалоговом окне Add Tool введите sde в поле Tool Name и выбери-

те sde в поле DB Tool; 

3) отметьте параметр After Selected Tool, чтобы добавляемый модуль 

следовал за Sentaurus Process (снимите отметку с параметра Use Ligament);  

4) установите, чтобы Sentaurus Structure Editor запускался в пакетном 

режиме, щелкнув правой кнопкой мыши иконку Sentaurus Structure Editor и 

выбрав Edit Input > Preferences, чтобы запустить диалоговое окно Edit 

Preferences; 

5) отметьте параметр Start in 

batch mode (рис. 5.27). 

Теперь необходимо задать ко-

мандный файл для Sentaurus Structure 

Editor. Аналогично, как для Sentaurus 

Process, щелкните иконку Sentaurus 

Structure Editor и выберите Import File 

> Commands, в появившемся диало-

говом окне найдите папку SWB_nmos 

и выберите sde_dvs.cmd. 

Чтобы добавить Sentaurus 

Device: 

1) выполните шаги 1–5, как для 

Sentaurus Structure Editor, но замени-

те sde на sdevice в качестве имени 

модуля; 

2) выберите sdevice в поле DB 

tool; 
3) импортируйте 

sdevice_des.cmd в качестве входного файла. 

Рис. 5.27. Диалоговое окно  

Edit Preferences  
для Sentaurus Structure Editor 

 



 

Аналогично выберите Import File > Parameter (Si Model), найдите пап-
ку SWB_nmos и выберите файл параметров sdevice.par. 

Чтобы добавить Inspect: 
1) повторите те же шаги, что и для Sentaurus Device, но замените sdevice 

на inspect в качестве имени модуля; 
2) выберите inspect в поле DB tool; 
3) импортируйте inspect_ins.cmd  в качестве входного файла; 
4) выберите Edit Input > Preferences и отметьте параметр Start in batch 

mode; 
5) щелкните OK. 

5.4.6.2. Сохранение проектов 

Когда проект составлен, его необходимо сохранить. 

1. Выберите пункт меню Project > Save As.  

2. Выберите папку, где необходимо сохранить проект.  

3. Сохраните проект под именем SWB_nmos_example. 

 
5.4.7. Выполнение экспериментов 

5.4.7.1. Добавление параметров 

Sentaurus Workbench позволяет добавить параметры и задать множество 

присваиваемых им значений для создания дерева экспериментов. Каждое 

значение параметра добавляет один эксперимент, поэтому для N значений 

параметра будет создано N экспериментов. Для двух параметров P1 и P2, 

имеющих соответственно M и N значений, будет создано M N возможных 

экспериментов. 

Покажем на примере использование параметров для Sentaurus Process, 

Sentaurus Structure Editor и Sentaurus Device. Пусть для Sentaurus Process за-

даются параметры: 

 имя структуры в параметре Type;  

 значение длины затвора (параметр lgate);  

 значение дозы имплантации галогенов (параметр HaloDose);  

 значение энергии имплантируемых галогенов (параметр HaloEnergy). 

Для Sentaurus Structure Editor задается значение концентрации примесей 

в области polygate (параметр PolyDop). 

Для Sentaurus Device задаются параметры: 

 начальное значение напряжения, подаваемого на затвор (параметр Vdd);  

 значение напряжения на стоке (параметр Vds). 

Чтобы создать каждый параметр (например, Type в Sentaurus Process), 

необходимо выполнить следующие действия. 

1. Щелкните правой кнопкой мыши в сером прямоугольнике, располо-

женном прямо под иконкой Sentaurus Process в главном окне Sentaurus 

Workbench, и выберите пункт контекстного меню Add.  

2. В диалоговом окне Add Parameter заполните поля, как показано на  

рис. 5.28. 



 

3. Щелкните OK. 
 
Чтобы добавить остальные пара-

метры, выполните следующее. 
1. Щелкните правой кнопкой на 

узел Type и выберите Add.  
2. В диалоговом окне Add Para- 

meter введите имя параметра lgate и 
значение по умолчанию 0,18.  

3. Повторите эти шаги для пара-
метра HaloDose со значением по умол-
чанию 1e13 и для HaloEnergy со значе-
нием 15. 

Теперь под иконкой Sentaurus Structure Editor добавьте параметр PolyDop 
со значением по умолчанию 6e19. 

Затем под иконкой Sentaurus Device добавьте параметр Vdd со значением 
по умолчанию 1,5 и Vds со значением 0,05. 

Главное окно Sentaurus Workbench должно принять вид, показанный на 
рис. 5.29. 

 

 

Рис. 5.29. Главное окно Sentaurus Workbench с добавленными параметрами 
 

Чтобы проверить, например, что параметр добавлен во входной файл 
Sentaurus Structure Editor sde_dvs.cmd, щелкните правой кнопкой на иконку 
Sentaurus Structure Editor и выберите Edit Input > Commands, чтобы открыть 
файл sde_dvs.cmd. 

(define PolyDop @PolyDop@) 

Для Sentaurus Device Vdd и Vds были добавлены следующим образом: 
 

{ Name=«gate» Voltage=!(puts [expr $SIGN*@Vdd@])! } 
{ Name=«drain» Voltage=!(puts [expr $SIGN*@Vds@])! } 

 

Рис. 5.28. Диалоговое окно  

Add Parameter 



 

Конструкции @PolyDop@, @Vdd@ и @Vds@ показывают, что это  

параметры, которые во время предварительной обработки будут заменены 

реальными значениями, заданными в определениях параметров. Значения 

всех параметров, добавленных в этом проекте, отображаются в файле пред-

варительной обработки. 

Чтобы выполнить предварительную обработку проекта, активируйте 

пункт меню Project > Preprocess или горячее сочетание клавиш Ctrl+P и по-

смотрите результаты (рис. 5.30). 

 

 

Рис. 5.30. Диалоговое окно Preprocessor Log 

5.4.7.2. Создание множества экспериментов 

 

Рис. 5.31. Диалоговое окно  



 

Чтобы со- здать мно-

жество экспериментов, выполните следующее. 

1. Активируйте пункт меню Experiments > Add New Experiment.  

2. Введите значения, как показано на рис. 5.31. 

 

 

 

 

 

 

 

 
 

Повторите эти действия, указывая следующие значения: 

Experiment 3 
Type : nMOS 
lgate : 0.18 
HaloDose : 1e13 
HaloEnergy : 25 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 0.05 

Experiment 4  
Type : nMOS 
lgate : 0.18 
HaloDose : 1e13 
HaloEnergy : 25 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 1.5 

Experiment 5 
Type : nMOS 
lgate : 0.18 
HaloDose : 1e12 
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 0.05 

Experiment 6 
Type : nMOS  
lgate : 0.18 
HaloDose : 1e12 
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5  
Vds : 1.5 

Experiment 7 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e13  
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 0.05 

Experiment 8 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e13 
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 1.5 

Experiment 9 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e13 
HaloEnergy : 25 
PolyDop : 6e19 
Vdd : 1.5  
Vds : 0.05 

Experiment 10 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e13 
HaloEnergy : 25 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 1.5 

Experiment 11 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e12 
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 0.05 

Experiment 12 
Type : nMOS 
lgate : 0.13 
HaloDose : 1e12 
HaloEnergy : 15 
PolyDop : 6e19 
Vdd : 1.5 
Vds : 1.5 

  

 

 

Когда все эксперименты добавлены, очистите проект следующим образом.  

Add New Experiment dialog box 



 

Активируйте пункт меню Project > Clean Up и задайте необходимые 

параметры (рис. 5.32). 

 

Рис. 5.32. Диалоговое окно Clean Up Options 
 

Главное окно Sentaurus Workbench должно выглядеть так, как показано 

на рис. 5.33. 
 

 

Рис. 5.33. Главное окно с экспериментами 
 

 

Если необходимо добавить ряд 

значений параметра с определенным 

шагом, щелкните правой кнопкой на 

имя параметра и выберите Add Values, 

затем введите значения, как показано 

на рис. 5.34. 
 

 

 

 



 

 

Рис. 5.34. Диалоговое окно  

Add Parameter Values 

 

5.4.7.3. Предварительная обработка и запуск проектов 

Когда создание проекта завершено, проверьте его работоспособность  

посредством предварительной обработки файлов. 

Чтобы осуществить предварительную обработку, активируйте пункт  

меню Project > Preprocessing or Ctrl+P. 

Когда предварительная обработка успешно завершена, запустите проект: 

Project > Run. 

После расчета последнего узла экстрагированные значения попадают  

в таблицу дерева семейств и отображаются в главном окне. 
 

6. ПРИМЕРЫ ИСПОЛЬЗОВАНИЯ SYNOPSYS TCAD 

6.1. Пример 1. Полупроводниковый резистор  
на полуизолирующей подложке GaAs 

В данном примере рассмотрим создание проекта моделирования полу-

проводникового резистора, изготовленного на полуизолирующей подложке 

из арсенида галлия. Для упрощения модели не будем рассматривать эффекты 

генерации и рекомбинации носителей заряда в структуре, а также эффекты, 

связанные с саморазогревом прибора.  

Резистор состоит из равномерно легированного эпитаксиального слоя 

арсенида галлия толщиной 0,1 мкм, выращенного на полуизолирующем бу-

ферном слое (ненамеренное легирование 10
14

 см
–3

 p-типа) арсенида галлия. 

Области омических контактов истока и стока легированы до уровня 10
19

 см
–3

 

с целью обеспечения хорошего омического контакта. Для уменьшения гео-

метрических размеров структуры сама полуизолирующая подложка не рас-

сматривается. 

Целью моделирования является получение вольт-амперных характери-

стик резистора, а также расчет распределения напряженности электрического 

поля в структуре для определения места, где вероятнее всего произойдет 

пробой полупроводника. 

 
6.1.1. Создание нового проекта и задание структуры устройства 

Запустите Sentaurus Workbench и создайте новый проект. Затем добавьте 

в него программный модуль Mesh. Щелкните правой кнопкой мыши по до-

бавленному значку и выберете пункт меню Edit input > Boundary... Запустится 

программный модуль Sentaurus Structure Editor (SDE).  

Для задания границ устройства включите режим точных координат 

(Exact Coordinates), выберите в качестве материала арсенид галлия (GaAs)  



 

и нарисуйте прямоугольник с углами в точках (0;0) и (3;2), данная прямо-

угольная область будет представлять сечение резистора плоскостью X–Y. По-

сле создания основной области необходимо выделить области канала и оми-

ческих контактов. Для этого выберите в пункте меню Mesh > Define Ref/Eval 

Window > Rectangle и задайте прямоугольную область с углами в точках  

(0; 0) и (3; 0,1) – это будет область канала. Для задания областей омических 

контактов проделайте эту же процедуру, создав прямоугольные области с 

координатами (0; 0), (0,5; 0.3) и (2,5; 0), (3; 0,3). 

После того как обозначены границы устройства и его области, необ- 

ходимо обозначить уровни легирования заданных областей. Сначала за- 

дайте легирование полуизолирующей области структуры. Для этого выберите 

пункт меню Device > Constant Profile Placement... В открывшемся диалоговом 

окне в секции Placement Type выберите Region > region_1, в секции Constant 

Profile Definition задайте имя (Name) Background и концентрацию 

(Concentration) 1e14, в поле Species нужно оставить BoronActiveConcentration, 

так как заданная примесь имеет p-тип легирования. Нажмите кнопку Add 

Placement, после этого создастся профиль фонового легирования структуры. 

Для создания профиля легирования канала измените Placement Name на 

ConstantProfilePlacement_2, выберите в Placement Type вариант Ref/Eval 

Window, а напротив него укажите Ref/EvalWin_1 (это обозначение области 

канала). В Constant Profile Definition задайте имя Channel, в качестве легиру-

ющей примеси (Species) выберите ArsenicActiveConcentration (дает примесь 

n-типа) и уровень легирования 3.5e17. Уровни легирования областей омиче-

ских контактов задайте самостоятельно. 

Когда уровни легирования областей заданы, нужно задать параметры ге-

нерации сетки. Для упрощения задачи ограничимся заданием грубой сетки в 

области полуизолирующего буферного слоя и второй, более детальной, сетки 

в области активного слоя. Для того чтобы задать параметры сетки в какой-

либо области устройства, необходимо открыть диалоговое окно, выбрав 

пункт меню Mesh > Refinement Placement..., задать имя создаваемой сетки 

(Placement Name), задать область, в которой эта сетка будет расположена 

(Placement Type), ввести размеры максимального и минимального элемента 

сетки в каждом направлении (Max Element Size и Min Element Size) и нажать 

кнопку Add Placement. Для задания грубой сетки в качестве области выберите 

Region > region_1, а максимальный и минимальный размер элементов в каж-

дом направлении задайте 0,05. После этого задайте мелкую сетку с шагом 

0,01 в области Ref/Eval Window > RefEvalWin_1. 

Завершающим шагом создания структуры является задание контактных 

областей. Для того чтобы добавить контактные области на верхнюю часть 

канала резистора, необходимо обозначить размеры этих областей. Для отде-

ления областей контактов от остальной поверхности канала добавьте в струк-

туру две вершины (кнопка Add Vertex) с координатами (0,5; 0) и (2,5; 0). По-

сле этого зайдите в диалоговое окно Contacts > Contact Sets, введите имя 

контакта (Contact Name) source и нажмите кнопку Set, затем выберите вновь 

созданный контакт в левом окошке и нажмите кнопку Activate, закройте диа-

логовое окно. Для задания местоположения контакта установите уровень вы-



 

деления – край полигона (Selection Level > Edge в контекстном меню), выбе-

рите область истока (после выбора область выделяется толстой оранжевой 

линией) и нажмите Contacts > Set Contact – выделенная область должна окра-

ситься в красный цвет. Таким же образом создайте контакт к стоку транзи-

стора (имя контакта должно быть drain). 

После того как структура создана, необходимо ее сохранить. Выберите 

пункт меню File > Save Model As... Введите в качестве имени сохраняемого 

файла mesh_msh.cmd. После этого выберите File > Save Boundary As... и со-

храните файл под именем mesh_msh.bnd. Задание этих имен необходимо, 

чтобы Sentaurus Workbench смог автоматически использовать их при проце-

дуре предварительной обработки. 

Закройте Sentaurus Structure Editor и вернитесь в окно проекта SWB.  

Запустите первый узел проекта. Если все было сделано правильно, то процесс 

создания сетки пройдет успешно и узел окрасится в желтый цвет. 

 

 
6.1.2. Создание командного файла Sentaurus Device 

После того как задана структура устройства и создана сетка, на которой 

будет решаться ФСУ, необходимо написать командный файл для Sentaurus 

Device. В проекте SWB добавьте программный модуль sdevice, щелкните на 

добавленный значок правой кнопкой мыши и выберите Edit Input > 

Commands... Так как писать командный файл с нуля достаточно долго, реко-

мендуется использовать шаблон, изменяя который, можно добиться требуе-

мых результатов. В качестве шаблона можно использовать, например, такой 

файл: 
 

File { 
  

 Grid = «@grid@»  
 Doping=«@doping@» 
  

 Plot = «@dat@» 
 Current = «@plot@» 
 Output = «@log@» 
 } 
 

Electrode { 
 { Name=«source» Voltage=0.0 } 
 { Name=«drain» Voltage=0.0} 
 { Name=«gate» Voltage=0.0 Barrier=-0.55 } 
 } 
 

Physics { 
 Mobility (DopingDependence HighFieldSat Enormal) 
 EffectiveIntrinsicDensity (BandGapNarrowing (OldSlotboom)) 
 } 
 

Plot { 
 eDensity hDensity eCurrent hCurrent 
 Potential SpaceCharge ElectricField 
 eMobility hMobility eVelocity hVelocity 



 

 Doping DonorConcentration AcceptorConcentration 
 } 
 

Math { 
 Extrapolate 
 RelErrControl 
 } 
 

Solve { 
 #-initial solution: 
 Poisson 
 Coupled { Poisson Electron } 
 #-ramp gate: 
 Quasistationary (  
  Goal{ Name=«gate» Voltage=2 } ) 
  { Coupled { Poisson Electron } } 
}   
 

Секцию File оставим без изменений, так как в качестве имен входных и 

выходных файлов указаны названия переменных. SWB сам подставит нуж-

ные имена при процедуре предварительной обработки.  

В секции Electrode необходимо убрать отсутствующий в структуре элек-

трод с именем gate. Так как при создании структуры нами были использо- 

ваны имена электродов source и drain, то две первые строчки останутся  

без изменений. Итоговая секция Electrode будет выглядеть следующим обра-

зом: 
 

Electrode { 
 { Name=«source» Voltage=0.0 } 
 { Name=«drain» Voltage=0.0} 
 } 
 

Для максимального упрощения физической секции ограничимся моде-

лью подвижности, зависящей от температуры и концентрации легирующей 

примеси в полупроводнике (DopingDependence), а также моделью насыщения 

скорости электронов в сильных электрических полях (HihgFieldSaturation). 

После включения данных моделей секция примет вид 
 

Physics { 
 Mobility (DopingDependence HighFieldSaturation) 
 } 

 

Секции Plot и Math оставим без изменений. 
В секцию Solve необходимо внести следующие изменения. Так как  

целью моделирования является получение зависимости тока стока от напря-
жения на стоке, то необходимо изменить имя электрода, на который будет 
подаваться напряжение. Изменив имя gate на drain и увеличив напряжение до 
5 В, получим: 

 

Solve { 
 #-initial solution: 
 Poisson 
 Coupled { Poisson Electron } 
  

 Quasistationary (  



 

  Goal{ Name=«drain» Voltage=5 } ) 
  { Coupled { Poisson Electron } } 
 }   

Командный файл готов. Сохраните его и запустите процесс моделирова-
ния. Если все было сделано правильно, то после завершения расчета соответ-
ствующий узел проекта станет желтого цвета.  

 
6.1.3. Результаты моделирования 

Для просмотра результатов моделирования щелкните правой кнопкой 
мыши на последнем узле и выберите Visualize > .plt Files > Inspect. Постройте 
график зависимости drain(TotalCurrent) от drain(OuterVoltage) (рис. 6.1).  
Нетрудно убедиться, что полученная кривая имеет омический участок и уча-
сток насыщения, т.е. полностью соответствует ВАХ полупроводникового  
резистора. В качестве самостоятельного упражнения можно убрать модель 
насыщения скорости электронов в сильных электрических полях из команд-
ного файла и посмотреть, какая ВАХ получится в этом случае. 

 

 

Рис. 6.1. Расчетная ВАХ полупроводникового резистора 



 

Чтобы отобразить распределение напряженности электрического поля по 

структуре, щелкните правой кнопкой мыши на узле и выберите пункт 

Visualize > .dat Files (Tecplot SV). В открывшемся окне выберите переменную 

с именем ElectricField (рис. 6.2). Как видно из рисунка, максимальная напря-

женность электрического поля располагается в области стока, именно в этом 

месте и начнет происходить пробой структуры.  

 
 

Рис. 6.2. Расчетное распределение напряженности электрического поля 

6.2. Пример 2. Диод Шоттки на подложке GaAs 

В данном примере рассмотрим процедуру моделирования диода Шоттки 

на основе контакта металл – арсенид галлия. Для выполнения этого примера 

необходим проект SWB, созданный в ходе работы над примером 1. Заданная 

в примере 1 структура будет дополнена путем добавления контакта Шоттки 

на поверхность полупроводникового резистора. 

Целью моделирования является получение прямой и обратной ветвей 

диодной ВАХ. В дополнение к этому рассмотрим область контакта металл –

полупроводник при прямом и обратном смещении на затворе. 

 
6.2.1. Модификация структуры прибора  

Откройте созданный ранее проект SWB и сохраните его под другим 

именем. После этого запустите SDE для редактирования файла *.bnd инстру-

мента Mesh, как это было описано в предыдущем примере. Для того чтобы 

добавить контакт Шоттки на поверхность полупроводника между истоком и 

стоком, необходимо создать две точки (Add Vertex) с координатами (1,25; 0) 



 

и (1,75; 0). После добавления точек создайте контакт с именем gate и распо-

ложите его между точками. Сохраните получившуюся структуру. По сути, 

полученный прибор является полевым транзистором, в процессе моделиро-

вания напряжение на стоке и истоке транзистора будет поддерживаться рав-

ным нулю, что соответствует так называемому диодному включению транзи-

стора. 
6.2.2. Модификация командного файла Sentaurus Device 

Вернитесь в окно проекта SWB и откройте для редактирования команд-
ный файл SDevice. Добавьте в секцию Electrode описание электрода gate. Так 
как контакт не является омическим, то в его описание необходимо добавить 
высоту барьера и указать, что будет использоваться модель Шоттки. Итого-
вая секция Electrode будет иметь следущий вид: 

 

Electrode { 
 { Name=«source» Voltage=0.0 } 
 { Name=«drain» Voltage=0.0} 
 { Name=«gate» Voltage=0.0 Schottky Barrier=0.7 } 
 }  
 

Внесение изменений в секции Physics, Plot и Math не требуется. 
Для того чтобы получить ВАХ диода, необходимо приложить к нему 

прямое и обратное напряжение. Измените секцию Solve так, чтобы она вы-
глядела следующим образом: 

 

Solve { 
 #-initial solution: 
 Poisson 
 Coupled { Poisson Electron } 
  
 Quasistationary ( MaxStep=0.02 
  Goal{ Name=«gate» Voltage=@Vg@ } ) 
  { Coupled { Poisson Electron } } 
 } 

Команда MaxStep задает максимальный шаг (относительный), с которым 
будет изменяться напряжение на затворе. Например, при конечном напряже-
нии 1 В шаг будет равен 1  0,02 = 0,02 В.  

Еще одним изменением данной секции командного файла является зада-
ние конечного напряжения не константой, а переменной @Vg@. Значения 
переменной будут заданы в проекте SWB и перед запуском SDevice записаны 
в командный файл. 

Сохраните командный файл и вернитесь в окно проекта SWB. Для того 
чтобы задать значения переменной @Vg@, щелкните правой кнопкой мыши 
по серому прямоугольнику под инструментом Sdevice и выберите пункт 
Add... В появившемся диалоговом окне в строке Parameter введите имя пере-
менной Vg, в строке Default Value введите –1. В проекте появилась новая пе-
ременная, имеющая значение –1. Это максимальный уровень обратного 
напряжения (в вольтах), которое будет подаваться на диод. Для того чтобы 
задать максимальный уровень прямого напряжения, щелкните правой кноп-
кой мыши по переменной и выберите в меню пункт Add Values... В поя- 
вившемся диалоговом окне задайте следующие параметры: Min. Value = –1, 



 

Step = 2, Number of Values = 2. Теперь в проекте переменная Vg имеет два 
значения: –1 и 1. Выделите эти значения мышью и запустите расчет. 

 

 

 

 
6.2.3. Результаты моделирования 

После того как расчет будет завершен, откройте файл *.plt, соответству-
ющий напряжению –1 В, и постройте график зависимости gate(TotalCurrent)  
от gate(OuterVoltage). Как видно из графика, при подаче отрицательного 

смещения через диод протекает 

небольшой обратный ток (ток 

имеет знак минус). Для того 

чтобы загрузить файл с данны-

ми, полученными при прямом 

смещении, откройте файл 

n6_des.plt (File > Load Dataset...) 

и постройте ВАХ на уже имею-

щемся графике. Как видно из 

рисунка, ток остается малым до 

значений прямого напряжения 

0,5–0,6 В. После того как прямое 

напряжение становится больше 

высоты барьера Шоттки (0,7 В), 

ток через диод начинает резко 

возрастать. Нетрудно убедиться, 

что полученная ВАХ соответ-

ствует ВАХ диода (рис. 6.3). 

Для детального рассмотрения области контакта металл – полупроводник 

откройте соответствующие файлы *.dat в программном модуле Tecplot. Вы-

ведите на экран значение переменной eDensity (рис. 6.4).  

Рис. 6.3. Расчетная ВАХ диода Шоттки 



 

 
Рис. 6.4. Расчетная концентрация электронов для обратного (слева)  

и прямого (справа) включения диода 

Как видно из рисунков, при отрицательном смещении под контактом 

gate образовалась область обеднения, концентрация электронов в которой 

составляет менее 10
4
 см

–3
, а при положительном смещении концентрация ос-

новных носителей заряда под контактом примерно равна концентрации леги-

рующей примеси. Данные наблюдения объясняют полученную форму ВАХ. 

6.3. Пример 3. Полевой транзистор Шоттки на подложке GaAs 

Целью этого примера является создание физической модели полевого 

транзистора Шоттки (ПТШ) на основе арсенида галлия. В ходе расчета будут 

получены ВАХ, а также изучены некоторые физические явления, происходя-

щие внутри транзистора. 

Для успешного выполнения примера необходимо наличие проекта, со-

зданного в примере 2, модификация структуры не требуется, изменения бу-

дут вноситься только в командный файл SDevice и проект SWB.  

 
6.3.1. Модификация командного файла Sentaurus Device 

Откройте в окне SWB проект, созданный в примере 2, и сохраните его 

под другим именем. Откройте командный файл SDevice для редактирования. 

Изменений потребует только секция Solve. Для того чтобы получить набор 

ВАХ зависимости тока стока от напряжения стока для различных напряжений 

на затворе, необходимо модифицировать секцию Solve следующим образом: 
 

Solve { 
 #-initial solution: 



 

 Poisson 
 Coupled { Poisson Electron } 
 
 Quasistationary ( MaxStep=0.02 
  Goal{ Name=«gate» Voltage=@Vg@ } ) 
  { Coupled { Poisson Electron } }  
 
 Quasistationary ( MaxStep=0.02 
  Goal{ Name=«drain» Voltage=@Vd@ } ) 
  { Coupled { Poisson Electron } } 
 }   
 

Нетрудно заметить, что в секцию добавился еще один блок 

Quasistationary, внутри которого переменной @Vd@ задано конечное значе-

ние напряжения на стоке транзистора. При выполнении модифицированного 

командного файла расчет будет происходить следующим образом. Сначала 

напряжение на затворе увеличится до значения @Vg@ при неизменном и 

равном нулю напряжении на стоке. После того как значение напряжения на 

затворе достигнет @Vg@, начнет расти напряжение на стоке. Увеличение 

будет продолжаться до значения @Vd@, при этом напряжение на затворе 

сохраняется равным @Vg@. Таким образом, задав значение переменной 

@Vd@=5 В и значения для переменной @Vg@ = 1, 0, –1, –2, –3 В, мы смо-

жем получить семейство ВАХ полевого транзистора с затвором Шоттки. 

Чтобы задать значения переменных, необходимо проделать следующие 

действия: добавить переменную с именем Vd и значением по умолчанию 5 

перед переменной Vg (флажок Before Selected Step в окне добавления пере-

менной), открыть окно добавления значений переменной Vg и заполнить его 

следующим образом: Min. Value = 0, Step = –1, Number of Values = 4. После 

этого в проекте будет 5 узлов, которые необходимо выделить и запустить 

расчет. 

 
6.3.2. Результаты моделирования 

Для построения ВАХ зависимости тока стока от напряжения на стоке 

выделите все пять рассчитанных узлов и откройте соответствующие им фай-

лы *.plt в программе Inspect (рис. 6.5).  

 

 



 

 
 

Рис. 6.5. Расчетные ВАХ транзистора 

 
Как видно из графика, ток стока хорошо модулируется напряжением на 

затворе, т.е. модель транзистора работает нормально. Единственным исклю-

чением является ветвь ВАХ при напряжении на затворе, равном 1 В. Форма 

этой ветви объясняется тем, что при нулевом напряжении на стоке и доста-

точно большом смещении на затворе относительно стока через контакт Шот-

тки начинает течь большой прямой ток (соответственно такой же ток начина-

ет течь через сток, только в обратном направлении, что и обусловливает его 

отрицательный знак). По мере того как напряжение на стоке транзистора воз-

растает, разность напряжений между затвором и стоком начинает умень-

шаться и при определенном значении этой разности ток стока становится по-

ложительным. Данный режим работы транзистора (когда через затвор 

протекает большой ток) является нежелательным, поскольку приводит к 

быстрой деградации параметров транзистора и даже его физическому повре-

ждению. Таким образом, из результатов расчетов можно сделать вывод, что рас-

сматриваемый транзистор может работать при напряжениях на затворе от 0 до –

3 В. 



 

Чтобы визуализировать некоторые физические параметры структуры и 

рассмотреть ряд физических процессов, откройте файлы *.dat результатов 

симуляции в программном модуле Tecplot. Выберите переменную 

ElectricField для отображения (рис. 6.6). Как видно из рисунка, наибольшее 

значение напряженности электрического поля получается при максимальном 

отрицательном смещении на затворе (Vg = –3 В), что вполне объяснимо, так 

как разность напряжений между затвором и стоком в этом случае будет мак-

симальной (8 В). Нетрудно убедиться, что, в отличие от полупроводникового 

резистора, максимальная напряженность электрического поля расположена 

не возле стока, а возле стокового края затвора, т.е. пробой транзистора будет 

происходить именно в этом месте. 

Далее рассмотрим переменную eCurrentDensity, которая хранит значения 

плотности электронного тока в каждой точке структуры (рис. 6.7). Из рисун-

ка наглядно видно, как происходит закрытие транзистора при увеличении 

отрицательного напряжения на затворе. Обратите внимание на форму обед-

ненной области. При небольших отрицательных смещениях на затворе обед-

ненная область имеет утолщение на стоковом крае затвора. При увеличении 

отрицательного смещения ее форма меняется и при закрытии транзистора 

становится практически симметричной. 
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6.4. Пример 4. AlGaAs/GaAs транзистор 
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В примере продемонстрирован процесс создания проекта для гетеро- 

структурного AlGaAs/GaAs транзистора с высокой подвижностью электронов 

(High Electron Mobility Transistor – HEMT). Далее будем называть его GaAs 

HEMT. Основным отличием данного вида транзистора от GaAs ПТШ являет-

ся то, что ток в GaAs HEMT течет в нелегированном слое GaAs, в то время 

как в ПТШ ток течет в канале, легированном до уровня 3,5  10
17

 см
–3

. Извест-

но, что уровень легирования существенно влияет на подвижность носителей 

заряда в полупроводнике, а следовательно, и на рабочие характеристики 

транзистора. Для того чтобы обеспечить максимальную подвижность, кон-

центрацию легирующей примеси необходимо минимизировать. Однако если 

не легировать канал GaAs ПТШ, то в нем не будет течь ток, так как нелегиро-

ванный GaAs является полуизолятором. Для того чтобы обойти это ограни-

чение, используется гетеропереход AlGaAs/GaAs. Контактный слой широ-

козонного полупроводника AlGaAs легируется до уровня 10
18

 см
–3

, канал 

GaAs остается нелегированным. Так как на гетеропереходе AlGaAs/GaAs об-

разуется квантовая яма, то часть электронов из легированного контактного 

слоя попадает в эту яму, которая располагается в канальном слое GaAs. Та-

ким образом, в области канала образуется двумерный электронный газ, по-

движность электронов которого гораздо больше, чем в стандартном GaAs 

ПТШ. 

Для выполнения расчетов понадобится проект примера 3, будут получе-

ны ВАХ GaAs HEMT и построена энергетическая зонная диаграмма. 

 
6.4.1. Модификация структуры 

Откройте созданный в примере 3 проект SWB и сохраните его под дру-

гим именем. В SDE откройте для редактирования файл mesh_msh.bnd, после 

этого импортируйте файл mesh_msh.cmd (File > Import...). Сначала необходи-

мо изменить материал полупроводника на AlGaAs. Для этого выделите всю 

структуру, из списка материалов выберите AlGaAs, а в главном меню выбе-

рите пункт Edit > Change Material. Затем необходимо добавить область кана-

ла, для этого выберите пункт меню Draw > Overlap Behavior > New Overlaps 

Old. При включении данной опции вновь добавляемые регионы будут пере-

крывать старые в случае наложения друг на друга. Добавьте прямоуголь- 

ную область материала GaAs с координатами (0; 0,05) и (3; 0,075), сохраните 

файл *.bnd.  

Далее необходимо изменить легирование структуры. Для этого выберите 

ConstantProfilePlacement_2 в диалоговом окне Constant Profile Placement,  

установите флажок Define Ref/Eval Window и введите координаты верхнего 

прямоугольника AlGaAs (X1 = 0; X2 = 3; Y1 = 0; Y2 = 0,05; Z1 = 1; Z2 = 2), в 

полях Constant Profile Definition выберите Species=ArsenicActiveConcentration, 

Concentration=1e18 и нажмите кнопку Change Placement. Сохраните файл 

*.cmd. 

 

 
6.4.2. Модификация командного файла SDevice 



 

Откройте командный файл SDevice для редактирования. Секции File, 

Electrode и Physics оставьте без изменений, после секции Physics добавьте 

следующие строки: 
 

Physics (Material=«AlGaAs») { 
 MoleFraction(xFraction=0.26 Grading=0) 
} 
 

Это секция Physics, определенная только для материала AlGaAs. В ней 

задана мольная доля алюминия в тройном растворе AlGaAs, исходя из кото-

рой рассчитывается ряд основных параметров полупроводника (например, 

ширина запрещенной зоны и диэлектрическая проницаемость). 

В секцию Plot необходимо добавить переменные ValenceBandEnergy и 

ConductionBandEnergy. Секции Math и Solve оставьте без изменений. Сохра-

ните командный файл и запустите расчет. 

 
6.4.3. Результаты моделирования 

Откройте файлы *.plt в программном модуле Inspect и постройте ВАХ 

(рис. 6.8). Если сравнить полученные характеристики с ВАХ ПТШ, нетрудно 

заметить, что расстояние между ветвями при 0 и –1 В на затворе HEMT го-

раздо больше. Это означает, что при одном и том же изменении напряжения 

на затворе изменение тока стока GaAs HEMT гораздо больше, чем у GaAs 

ПТШ, т.е. крутизна характеристики транзистора с гетеропереходом суще-

ственно больше, чем обычного транзистора с легированным каналом. В каче-

стве упражнения для самостоятельного изучения рекомендуется произвести 

расчеты ВАХ данных транзисторов и получить зависимости тока стока от 

напряжения на затворе при фиксированном напряжении на стоке, равном, 

например, 5 В, затем сравнить эти кривые, а также производные этих кривых 

(производная кривой зависимости тока стока от напряжения на затворе есть 

кривая зависимости крутизны от напряжения на затворе). 

Как видно из рисунка, отсечка HEMT наступает при напряжении на за-

творе –2 В. 

Для того чтобы построить зонные диаграммы, необходимо произвести 

моделирование работы прибора при нулевых напряжениях на стоке и затворе. 

Для этого измените в командном файле SDevice напряжение на затворе с 5 В 

на 0 В и запустите расчет узла с Vg = 0. После этого откройте файл *.dat  

с результатами расчетов в программном модуле Tecplot. Сделайте срез по оси 

X (X cut) в районе 1,5 мкм. Для отображения кривых зависимости энергий 

зоны проводимости и валентной зоны выберите в левом окне имена перемен-

ных ConductionBandEnergy и ValenceBandEnergy. После этого щелкните по 

кнопке Create Permanent Linemaps. Постройте зависимость распределения 

плотности электронов (переменная eDencity) на оси Y2 в логарифмическом 

масштабе. Итоговый график будет выглядеть, как показано на рис. 6.9. 

 



 

 
Рис. 6.8. Расчетные ВАХ GaAs HEMT 

 

Рис. 6.9. Энергетические зонные диаграммы 



 

Из рисунка видно, что минимальная энергия зоны проводимости в обла-

сти квантовой ямы (примерно 0,05 мкм вглубь структуры, т.е. там, где начи-

нается слой GaAs) лежит ниже уровня Ферми (0 эВ). Именно в этой области 

образуется двумерный электронный газ, что видно из распределения плотно-

сти электронов. Максимум плотности приходится на дно квантовой ямы в 

зоне проводимости. 

Можно также ознакомиться с описанием расчетов HEMT более сложной 

структуры [7]. 
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ПРИЛОЖЕНИЕ 

ВОПРОСЫ ДЛЯ САМОТЕСТИРОВАНИЯ 
 

1. Что такое приборно-технологическое моделирование? 
2. Какие задачи решают системы TCAD? 
3. Какая роль отводится TCAD в международной полупроводниковой 

дорожной карте? 
4. Какие основные модули входят в Synopsys TCAD? 
5. Какие возможности существуют в Synopsys TCAD для моделирования 

технологических процессов? 
6. Как называется и что позволяет выполнять программный модуль для 

моделирования приборов? 
7. Что понимают под виртуальным производством? 
8. Какие задачи решает TCAD в виртуальном производстве? 
9. Какие возможности предоставляет Synopsys TCAD для физического 

моделирования полупроводниковых светодиодов? 
10. Какими способами могут создаваться командные файлы для 

Sentaurus Process? 



 

11. Какими способами могут создаваться командные файлы для 
Sentaurus Device? 

12. Какие основные команды используются в Sentaurus Process? Пере-
числите их ключевые параметры. 

13. Из каких секций состоит командный файл Sentaurus Device? 
14. Для чего предназначен программный модуль Inspect, и какие основ-

ные возможности он предоставляет пользователю? 
15. Какую роль играет Sentaurus Workbench? 
16. Что такое маршрут модулей в Sentaurus Workbench? 
17. Каким образом посредством Sentaurus Workbench выполняются экс-

перименты? 


